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Základy práce s GIS  

ArcGIS Desktop 

Seznámení s pracovním prostředím ArcMap 
Po spuštění ArcMap uvidí uživatel prostředí tak, jak je zachyceno na obrázku 1. Základ              
pracovního prostředí ArcMap tvoří:  

● horizontální menu (File, Edit,...),  
● tabulka obsahu (Table of Contents) obsahující seznam načtených vrstev (na obrázku           

1 je možné vyčíst, že jsou načtené dvě vrstvy),  
● oblast zobrazení dat (mapové okno),  
● ikona pro spuštění vyhledávání (Search),  
● ikona pro spuštění ArcCatalog (Catalog) a  
● panely nástrojů. 

 



 
Obr. 1 Pracovní prostředí ArcMap. V mapovém okně jsou načtené dvě vrstvy (silniční síť ČR               
a hranice krajů z datové sady ArcČR® 500 verze 3.3). 
 
Ve výchozím nastavení se po spuštění ArcMap zobrazí dva panelů nástrojů - Tools a              
Standard. Panel nástrojů Tools obsahuje základní funkce (reprezentované pomocí ikon) pro           
práci s daty v aktivním datovém rámci (popis funkcí je uvedený na obrázku 2).  

 
Obr. 2 Popis funkcí z panelu nástrojů Tools (Nástroje). 

 
Panel nástrojů Standard obsahuje funkce, které může uživatel ArcMap znát i z jiných             
aplikací. Příkladem jsou hned první čtyři ikonky: 

 



První ikona slouží pro vytvoření nového mapového dokumentu, druhá pro otevření           
existujícího mapového dokumentu, třetí pro uložení aktuálního mapového dokumentu a          
čtvrtá pro tisk.  
 
ArcMap umožňuje zobrazit další panely nástrojů, na výběr je jich téměř 50 (Customize ->              
Toolbars). 
 
Popis formátu shapefile 
 
Shapefile je datový formát pro ukládání vektorových geografických dat (prostorová +           
atributová data) vyvinutý firmou Esri. Struktura formátu shapefile se povinně skládá z: 

● souboru s příponou *.shp, který obsahuje prostorová data, 
● souboru s příponou *.dbf, který obsahuje atributová data, 
● souboru s příponou *.shx, který propojuje prvek v souboru *.shp s odpovídajícím            

záznamem v souboru *.dbf. 

Přidání vrstvy z disku 
Pro načtení vrstvy (uložené například ve formátu shapefile) z disku slouží ikona Add Data              

. Pokud budeme často načítat data z nějakého konkrétního adresáře, lze si ho připojit              

pomocí ikony Connect to Folder . Vlastní přidání vrstvy pak provedeme jejím označením             
ze seznamu dostupných vrstev v daném adresáři a zvolíme Add. Přidat lze i více vrstev               
najednou (při výběru se přidrží klávesa Ctrl; obrázek 3 ilustruje přidání dvou vrstev ze              
souboru shapefile). 
 

 
Obr. 3  Přidání dvou vrstev (uložených jako shapefile) z disku. 
 
Po načtení vrstev do ArcMap se nám načtené vrstvy zobrazí v tabulce obsahu (Table of               
Contents, viz obrázek 1 - pracovní prostředí ArcMap). Načtené vrstvy se načtou do tzv.              
datového rámce (data frame). Datový rámec má několik vlastností, především: 

● název datového rámce (výchozí název je Layers), 



● souřadnicový systém datového rámce (coordinate system), 
● jednotky datového rámce (map units), 
● jednotky zobrazené v mapovém okně (display units). 

 
Pokud mají data načítaná do ArcMap definovaný souřadnicový systém, pak se informace o             
souřadnicovém systému nastaví pro datový rámec automaticky (společně s informacemi o           
jednotkách datového rámce a jednotkách zobrazených v mapovém okně). V opačném           
případě je potřeba (např. z důvodu správného provádění prostorových analýz) tyto           
informace nastavit ručně v dialogu Data Frame Properties, který je dostupný přes pravé             
tlačítko myši nad názvem datového rámce a volbou Properties. Potřebné informace o            
datovém rámci se pak nastavují v záložkách Coordinate System a General.  
 
Více o souřadnicových systémech v kapitole Transformace souřadnicových systémů a          
předmětu Matematická kartografie. 

Přidání vrstvy z webu - WMS 
ArcMap umožňuje kombinovat data z více zdrojů. Poměrně populárním a využívaným           
zdrojem dat pro práci v GIS se v posledních letech staly WMS služby, pomocí kterých je                
možné si například do GIS připojit ortofoto jako podkladovou vrstvu. 
 
Pro přidání dat do ArcMap jako WMS služby postupujeme v úvodu stejně jako při přidání dat                
z disku, pouze při zobrazení dialogu Add Data zvolíme možnost GIS Servers (viz obrázek 4 -                
Přidání WMS serveru). 
 

 
Obr. 4 Přidání WMS serveru 
 
Abychom mohli data pomocí WMS služby přidat, musíme znát přesnou URL adresu, na             
které jsou tato data k dispozici. URL adresu (kterou najdeme například na internetu), pak              
zadáme do pole s URL adresou. Na obrázku 5 je ukázka zadání URL adresy pro přidání                
WMS služby Českého úřadu zeměměřického a katastrálního (ČÚZK) poskytující ortofoto. 



 
Obr. 5 Přidání ortofota jako WMS služby ČÚZK 

 
Při kombinování dat z více zdrojů je potřeba ohlídat, aby data byla ve stejném              
souřadnicovém systému. Toto je i příklad zmíněné WMS služby ČÚZK poskytující ortofoto,            
která se poskytuje v souřadnicovém systému WGS-84. Pokud byla před načtením této WMS             
služby do ArcMap načtena data např. v souřadnicovém systému S-JTSK, zobrazí se při             
přidávání dat pomocí WMS služby informace, že se pokoušíme do ArcMap načíst data v              
jiném souřadnicovém systému, než jaký používá aktuální datový rámec (viz obrázek 6). 
 



 
Obr. 6 Pokud se do ArcMap pokusíme načíst data v odlišném souřadnicovém systému, než              
je aktuálně nastavený, zobrazí se varovné hlášení, která nás o této skutečnosti informuje. V              
tomto případě do ArcMap načítáme data pomocí WMS služby se souřadnicovým systémem            
WGS-84, přičemž aktuálně nastavený souřadnicový systém je S-JTSK. 
 
Abychom mohli data zkombinovat, je potřeba provést on-the-fly transformaci načítaných dat           
z WMS služby do souřadnicového systému datového rámce. Blíže o transformacích           
souřadnicových systémů v GIS v kapitole Transformace souřadnicových systémů v GIS. 
 
Po provedené transformaci souřadnicových systémů je možné data společně zobrazit v           
mapovém okně. Na obrázku 7 je ukázka kombinace dat z různých zdrojů - vrstva hranic               
katastrálních území je z datové sady ArcČR 500 (verze 3.3), podkladová vrstva je ortofoto              
načtené jako WMS služba ČÚZK. 
 



 
Obr. 7 Kombinace dat načtených z více zdrojů. Hranice katastrálních území jsou načtené ze              
shapefilu z disku, podkladová vrstva s ortofoto je načtena pomocí WMS služby.  

Přidání vrstvy z webu - Basemap  
Další možností přidání dat do ArcMap je načtení tzv. Basemap. Stejně jako v případě              
připojení WMS služby, i v tomto případě je potřeba mít aktivní připojení k internetu.              
Basemap lze načíst jako podkladovou mapu a je možné ji kombinovat s dalšími zdroji dat.               
Obrázek 8 znázorňuje nabídku přidání Basemap do ArcMap. 
 

 
Obr. 8 Přidání dat z Basemap  
 



 
Obr. 9 Kombinace podkladové mapy (Open Street Map) načtené jako Basemap a            
polygonové vrstvy s hranicemi městských obvodů a městských částí. 
 

Tvorba základní mapové symboliky 
Po načtení vrstvy do ArcMap se všechny prvky ve vrstvě zobrazí náhodně vybranou barvou.              
To je dáno tím, že v datech uložených ve formátu shapefile není uložena informace, jakou               
barvou se mají data po načtení zobrazit.  
 
Jedním ze způsobů, jak změnit symboliku prvků, je kliknout levým tlačítkem myši na aktuální              
symbol pod názvem vrstvy v tabulce obsahu.  
 



 
Obr. 10 Symbol Selector pro základní nastavení symboliky. Je možné nastavit barvu výplně,             
tloušťku a barvu obrysové čáry nebo editovat mapový symbol. 
 
Další možnost nastavení symboliky si zpřístupníme, pokud nad názvem vrstvy v tabulce            
obsahu klikneme pravým tlačítkem myši a zvolíme možnost Properties. Tím dojde k otevření             
dialogového okna Layer Properties. Pro nastavení symboliky nás bude zajímat záložka           
Symbology (viz obrázek 11). 
 

 
Obr. 11 Dialog Layer Properties a aktivní záložka Symbology pro nastavení symboliky prvků. 



 
Single Symbol 
 
Někdy je potřeba zobrazit všechny prvky ve vrstvě stejným symbolem. V takovém případě             
lze jednotný symbol nastavit pomocí Features -> Single Symbol. Pokud chceme zobrazit v             
tabulce obsahu vedle symbolu popisek, vepíšeme jej do pole v části Legend a zvolíme              
tlačítko Použít. 
 
Categories 
 

● Unique values 
Umožňuje nastavení symbolu jednotlivým prvkům na základě hodnoty vybraného         
atributu. Každá hodnota atributu tak představuje vlastní kategorii, pro kterou je           
možné nastavit symbol pro vykreslení. 

● Unique values, many fields 
Umožňuje nastavení symbolu jednotlivým kategoriím, přičemž kategorii zde        
představuje n-tice atributů, kde n = 1, 2 nebo 3. 

● Match to symbols in a style 
Umožňuje použít existující styl. To je vhodné například v případě, kdy více organizací             
sdílí stejný styl pro vizualizaci konkrétních dat, která se tak budou zobrazovat stále             
stejně, bez ohledu na to, kdo styl aplikoval. 

 
Quantities  
Prvky ve vrstvě mohou mít v atributové tabulce uložené číselné atributy. Tyto číselné atributy              
mohou být použité k zobrazení určitého množství (quantities). Konkrétně mohou číselné           
údaje reprezentovat: 

● množství, 
● poměr (podíl), 
● číselné hodnocení. 

 
ArcMap nabízí několik způsobů, jak informace o kvantitě reprezentovat v mapě, např.            
pomocí barev (colors), různou velikostí symbolů (graduated symbols), proporcionální         
velikostí symbolů (proportional symbols), teček (dot density) a kartodiagramů (charts). 
 
Kartodiagramy (Charts) (zdroj: http://old.gis.zcu.cz/studium/tka/Slides/kartodiagramy.pdf) 
 
Kartodiagramy neboli diagramové mapy jsou nejčastěji používány pro prezentaci         
statistických údajů. Na rozdíl od kartogramů vyjadřujeme hodnoty u kartodiagramů vždy v            
absolutní podobě (výjimku tvoří členění daného znaku, kde jsou hodnoty většinou uváděny v             
procentech). Více o tvorbě kartodiagramů v předmětu Tematická kartografie. 
 
Multiple Attributes  
 
Volba MultiAttributes -> Quantity by Category umožňuje zobrazit data podle kategorie a            
číselného atributu. Například u silniční sítě můžeme pomocí jednoho atributu reprezentovat           



typ komunikace (barvou) a dalším atributem reprezentovat dopravní intenzitu (tloušťkou          
linie).  
 
Popisky  
 
ArcMap umožňuje pro jednotlivé prvky zobrazit v mapovém okně popisky (labels). Zdrojem            
dat pro popisky jsou sloupce v atributové tabulce příslušné vrstvy. Nastavení sloupce, ze             
kterého chceme popisky zobrazit, provedeme v dialogu Layer Properties a záložce Labels.            
Zapnutí zobrazení popisků pak přes pravé tlačítko myši nad názvem vrstvy a zaškrtnutím             
volby Label Features. 
 

 
Obr. 12 Zobrazení vrstvy okresů se zapnutými popisky - názvy okresů. 
 
Pokud práci v ArcMap uložíme jako projekt (File -> Save; uložený projekt má koncovku              
mxd), po opětovném otevření bude mít vrstva nastavenou symboliku přesně tak, jako tomu             
bylo v době posledního uložení projektu. Pro přenos projektu na jiný počítač je doporučené              
nastavit u uloženého projektu relativní cesty (File -> Map Document Properties… -> Store             
relative pathnames to data sources). 

Seznámení s pracovním prostředím ArcCatalog 
 



 
Obr. 13 Pracovní prostředí ArcCatalog. 
 
V levé části ArcCatalog máme možnost si připojit adresář s (geografickými) daty. Seznam             
připojených adresářů pak vidíme v Catalog Tree. Kromě adresářů nacházejících se na            
lokálním disku si můžeme v ArcCatalog připojit i dostupné síťové adresáře, nebo definovat             
připojení k databázovému serveru či GIS serveru (např. připojení WMS serveru).  
 
ArcCatalog umožňuje prohlížet obsah aktuálního adresáře (záložka Contents), prohlédnout         
data (záložka Preview) a prohlédnout nebo vytvořit metadata (záložka Description). 
 
ArcCatalog se používá i například pro vytváření nových vrstev (shapefile), viz kapitola            
Tvorba a editace nové vrstvy v ArcCatalog. 
 

Tvorba mapy závislé na měřítku 
Vstupní data (vrstvy z datové sady ArcČR 500 verze 3.3): 

● Silnice_2016 
● SidlaBody 
● KrajePolygony  
● OkresyPolygony 
● Popis dat v 3.3.pdf (popis dat ArcČR 500 verze 3.3)  

 
Postupně vytvoříme z vrstvy silnic (Silnice_2016) 5 nových vrstev, které budou obsahovat: 

● dálnice,  
● rychlostní silnice,  



● silnice I. třídy, 
● silnice II. třídy,  
● silnice III. třídy a neevidované silnice. 

 
Z vrstvy obcí (SidlaBody) vytvoříme tři nové vrstvy: 

● města nad 100 tisíc obyvatel, 
● města nad 20 tisíc obyvatel (a současně maximálně 100 tisíc obyvatel), 
● ostatní města (501 - max. 20 tisíc obyvatel). 

 
Pro každou z nově vzniklých vrstev následně nastavíme mapovou značku a rozsah měřítek,             
kdy se má daná vrstva zobrazit a kdy nikoliv. Při úvodním načtení/zobrazení dat silnic může               
postačovat zobrazit pouze nejdůležitější silnice (dálnice, rychlostní silnice), při přiblížení se           
na konkrétní oblast pak necháme zobrazit i silnice I. třídy atd. To samé platí např. pro obce,                 
kdy nejprve můžeme nechat zobrazit obce s nejvyšším počtem obyvatel a postupně při             
přiblížení zobrazovat i obce s menším počtem obyvatel. 
 

 
Obr. 14 Zobrazení vrstev silnic a krajů po načtení do ArcMap. 
 
Atributovým dotazem (více o atributových dotazech v kapitole Atributové dotazy) vybereme z            
vrstvy silnic nejprve všechny dálnice. Z dostupného popisu dat (obr. 15) zjistíme, jakým             
způsobem poznat, které linie reprezentují právě dálnice. 
 



 
Obr. 15 Z dostupného popisu dat (uloženého v souboru Popis dat v 3.3.pdf) zjistíme, že třída                
silnice je rozlišena hodnotou atributu TRIDA. Dálnicím odpovídají všechny linie, které mají v             
atributové tabulce ve sloupci TRIDA hodnotu 1. 
 
Atributový dotaz (Selection -> Select by Attributes) pro vybrání všech dálnic z vrstvy silnic              
tak bude vypadat jako na obr. 16. 
 

 
Obr. 16 Vybrání všech dálnic z vrstvy silnice. 

 
Obr. 17 zobrazuje výsledek atributového dotazu pro vybrání všech dálnic. 



 
Obr. 17 Vybrané dálnice z vrstvy silnice. 
 
Vybrané dálnice uložíme do nové vrstvy. Nejprve stiskneme pravé tlačítko myši nad vrstvou             
Silnice_2016 v Table of Contents a zvolíme Data -> Export Data. V okně Export Data               
zvolíme Export: Selected features a cestu pro uložení nové vrstvy obsahující dálnice, viz             
obr. 18 a 19. Při ukládání nové vrstvy používejte názvy bez diakritiky a bez mezer, tedy                
např. dalnice (a nikoli dálnice). 
 

 
Obr. 18 Exportování vybraných dálnic do nové vrstvy dalnice. Exportujeme pouze vybrané 

prvky. 



 
Obr. 19 Data exportujeme do formátu shapefile. 

 
Po vytvoření nové vrstvy se nás ArcMap zeptá, zda-li chceme přidat exportovaná data             
(novou vrstvu) do ArcMap. Můžeme potvrdit, že ano a novou vrstvu přidat, případně ji              
můžeme načíst kdykoli později. Na obr. 20 je zobrazena načtená vrstva dálnic. Po načtení              
vrstvy s dálnicemi můžeme v Table of Contents změnit název, pod kterým se v ArcMap               
zobrazuje (klikneme na název vrstvy levým tlačítkem myši a upravíme jej). 
 

 
Obr. 20 Vrstva dálnic s nastavenou mapovou značkou. 
 
Obdobným způsobem, jako jsme vytvořili vrstvu dálnic, vytvoříme i další požadované vrstvy.            
Před novým výběrem (atributovým dotazem) nejprve vždy zrušíme předchozí výběr          
(Selection -> Clear Selected Features).  
Pro vytvoření vrstvy obsahující silnice III. třídy a neevidované silnice bude atributový dotaz             
vypadat jako na obr. 21. 
 



 
Obr. 21 Atributový dotaz pro výběr silnic III. třídy a neevidovaných silnic. 

 
Když vytvoříme všechny požadované třídy z vrstvy silnice, můžeme si je spojit do jedné              
logické skupiny Silnice (v Table of Contents pomocí klávesy Shift a levého tlačítka myši              
označit všech 5 vrstev se silnicemi, a poté přes pravé tlačítko myši zvolit Group). 
 
Následně vytvoříme ještě požadované tři vrstvy obcí, ze kterých si po vytvoření rovněž             
můžeme vytvořit logickou skupinu vrstev. 
 
Po vytvoření všech potřebných vrstev si tyto vrstvy načteme do ArcMap a přiřadíme             
požadovaný rozsah měřítek, při kterých se mají tyto vrstvy v mapovém okně zobrazovat.             
Obrázek 22 ilustruje nastavení měřítek pro vrstvu Dálnice na záložce General v okně Layer              
Properties. 
 



 
Obr. 22 Vrstva dálnice se bude zobrazovat v měřítku 1:2 000 000 a větším. 
 
Rozsah měřítek můžeme nastavit např. takto: 

● Kraje 1:2 000 000 a větší 
● Okresy 1:2 000 000 a větší 
● Silnice 

○ Dálnice 1:2 000 000 a větší 
○ Rychlostní silnice 1:1 500 000 a větší 
○ Silnice I. třídy 1:1 250 000 a větší 
○ Silnice II. třídy 1:1 000 000 a větší  
○ Silnice III. třídy a neevidované silnice  1:500 000 a větší 

● Města 
○ Města nad 100 tisíc obyvatel 1:2 000 000 a větší 
○ Města nad 20 tisíc obyvatel 1:1 000 000 a větší 
○ Ostatní města 1:500 000 a větší 

 
Výsledek si můžeme prohlédnout na obr. 23, kde jsou zobrazena data v měřítku 1:2 000 000                
(zobrazují se pouze hranice krajů a okresů, dálnice a největší města). 
 



 
Obr.23 Data se zobrazují v závislosti na aktuální měřítku. 
 
Tip: Volba Layers -> Reference Scale -> Set Reference Scale zajistí proporcionální zvětšení             
/ zmenšení kartografických symbolů. 
 
Tip: Pořadí kreslení kartografických symbolů pro vrstvy v rámci jedné logické skupiny vrstev             
(Group) můžeme zajistit pomocí nastavení: pravé tlačítko myši nad názvem skupiny v Table             
of Contents -> Properties -> Group (viz obr. 24). 
 

 
Obr. 24 Nastavení pořadí vykreslování vrstev pro vrstvy ze skupiny “Silnice”. 



ArcGIS Pro  
Praktické ukázky v následujících kapitolách jsou popisovány pro software ArcGIS Pro ve            
verzi 2.0. Postup v jiných verzích se může mírně lišit. Zájemcům o detailní seznámení se s                
prostředím ArcGIS Pro lze doporučit vyčerpávající sérii tutoriálů na stránkách:          
http://pro.arcgis.com/en/pro-app/get-started/pro-quickstart-tutorials.htm  
 
Následující popis poskytne základní vhled do prostředí ArcGIS Pro, nutný pro další kapitoly,             
ve kterých budou popisována konkrétní cvičení. Názvy jednotlivých částí pracovního          
prostředí, představené v této kapitole, budou používány i v dalších kapitolách, doporučujeme            
proto čtenářům se s nimi důkladně seznámit. 

Seznámení s prostředím 
Pro práci s ArcGIS Pro je nutné mít vytvořený uživatelský účet pro ArcGIS. Ten je možno                
založit na následující adrese: https://www.arcgis.com/home/createaccount.html. Po jeho       
vytvoření jsou vám k dispozici zkušební verze produktů Esri. 
 
Po spuštění vyzve ArcGIS Pro uživatele k přihlášení pomocí ArcGIS účtu (někdy též             
nazývaného jako účet pro ArcGIS Online, viz obrázek 25.  

 
Obr. 25 Přihlašovací obrazovka ArcGIS Pro 

http://pro.arcgis.com/en/pro-app/get-started/pro-quickstart-tutorials.htm
https://www.arcgis.com/home/createaccount.html


 
Práce v ArcGIS Pro je projektově organizována a proto první, co musí uživatel po přihlášení               
udělat, je zvolit existující nebo založit nový projekt. Na výběr má z několika šablon: 

● Blank - prázdný projekt 
● Global_Scene.aptx - šablona pro práci ve 3D v globálním souřadnicovém systému           

(např. WGS-84) 
● Local_Scene - šablona pro práci ve 3D v lokálním souřadnicovém systému 
● Map.aptx - šablona pro práci s mapou 

 
Pro první seznámení s aplikací ArcGISPro vybereme šablonu pro práci s klasickou            
dvojdimenzionální mapou (viz obrázek 26), 3D zobrazení do ní lze kdykoli později připojit.  
  

 
Obr. 26 Založení nového projektu v ArcGIS Pro 
 
Na disku se následně ve specifikované složce (zde ..\Dokumenty\ArcGIS\Projects) založí          
nová složka “MojePrvniMapa”. Doporučuje se nepoužívat speciální symboly, ani diakritiku.          
Tohoto doporučení je vhodné se držet při veškeré další práci se software. 
 
Po otevření projektu vidí uživatel následující pracovní prostředí (viz obrázek 27): 



 
Obr. 27 Projekt v ArcGIS Pro 
 
Základ pracovního prostředí ArcGIS Pro tvoří tzv. Pás Karet resp. Pás Záložek (nazývány             
Tabs v nápovědě k ArcGIS Pro). Jednotlivé záložky (Project, Map, Insert,...) se skládají ze              
Skupin nástrojů. Na obrázku 28 je aktivní záložka Map, sdružující nástroje pro práci s              
mapou: skupiny nástrojů Clipboard, Navigate, Layer, … .  

 
Obr. 28 Záložka Map, Copyright © 2017 Esri. 
 
V závislosti na typu práce s ArcGIS Pro se mohou v pásu záložek objevovat nové záložky.                
Například záložka Table: View při práci s tabulkou nebo záložky Feature Layer: Appearance,             
labeling a Data, při práci s vektorovou vrstvou, viz obrázek 29. 
 

 



Obr. 29 Interaktivní změna pásu záložek při práci s tabulkou. Aktivní záložka Table: View, v               
pozadí aktivována i záložky Feature Layer: Appearance, labeling a Data. 
 
Uprostřed aplikace samozřejmě zaujme Mapové okno (Map view) s přednastavenou          
podkladovou mapou (Background map), ovšem důležitý je i Panel obsahu projektu (Content            
pane) po levé straně a Katalogový panel (Catalog pane) vpravo . Na obrázku 27 je vidět m.j.                1

i kontextová nápověda, která vyběhne po najetí myší na libovolný prvek pracovního            
prostředí - v tomto případě na nástroj Explore, umožňující intuitivní procházení mapy.  
 
Content pane má několik graficky vyznačených záložek, počínaje Výpisem vrstev podle           
pořadí, jak se v mapě vykreslují (odspodu nahoru) ~ List By Drawing Order, přes List By                
Data Source ~ výpis podle umístění zdroje dat na disku, až po výpis všech grafů použitých v                 
projektu (List By Charts), viz obr. 30. 
 
Okno Python ve spodní části slouží k automatizaci často prováděných operací, ocení jej             
spíše až zkušenější uživatelé, pro začátečníky je doporučeno toto okno vypnout.  
 
 

 
Obr. 30 Content pane. 

Catalog pane je dále dělen na záložky (Project, Portal, Favorite, …). Aktivní záložka Project              
(viz obr 27) obsahuje složky, ve kterých lze nalézt mapy, sady nástrojů (Toolboxes), data              
(Databases) a další součásti projektu MojePrvniMapa,aprx. 
 

Přidání vrstvy z disku 

Pro načtení vrstvy z disku slouží ikona Add Data v záložce Map. Pokud budeme často                
načítat data z nějakého konkrétního adresáře, lze si ho připojit pomocí ikony Connect to              

Folder v záložce Insert. Vlastní přidání vrstvy pak provedeme jejím označením ze             
seznamu dostupných vrstev v daném adresáři a zvolíme Add. Přidat lze i více vrstev              
najednou po přidržení klávesy Shfit nebo Ctrl. Obrázek 31 ilustruje přidání dvou vrstev typu              
shapefile (více viz infobox na straně XY). 

1 Rozmístění panelů může uživatel měnit. 



 

 
Obr. 31  Přidání dvou vrstev typu shapefile z disku. 
 
Po načtení se vrstvy zobrazí v Panelu obsahu (Content pane) a samozřejmě do mapového              
okna (Map view).  
 
Mapové okno má několik vlastností, především: 

● název mapy (výchozí název je Map), 
● souřadnicový systém mapy (coordinate system), 
● jednotky mapy (map units) ~ metry / kilometry / míle / stupně, atp., 
● jednotky zobrazené v mapovém okně (display units), 
● .. a další 

Všechny vlastnosti mapy jsou dostupné po kliknutí pravým tlačítkem na název mapy v             
Contents pane (viz např. “Map” na obrázku 30.)  pod volbou Properties.  2

 
Pokud mají data načítaná do ArcGIS Pro definovaný souřadnicový systém, pak se informace             
o souřadnicovém systému nastaví pro Mapu automaticky (společně s informacemi o map            
units a display units).  
 
V opačném případě je potřeba (např. z důvodu správného provádění prostorových analýz)            
tyto informace nastavit ručně v dialogu Data Frame Properties, který je dostupný přes pravé              

2 Princip kontextových menu funguje na většině prvků v prostředí ArcGIS Pro. Po kliknutí pravým 
tlačítkem na název vrstvy lze zobrazit vlastnosti vrstvy, atp. 



tlačítko myši nad názvem datového rámce a volbou Properties. Potřebné informace o            
datovém rámci se pak nastavují v záložkách Coordinate System a General.  
 
Více o souřadnicových systémech v kapitole Transformace souřadnicových systémů a          
předmětu Matematická kartografie. 

Tvorba mapových výstupů v GIS 
 
Kartogram  
Kartogram je mapa s dílčími územními celky, do kterých jsou plošným způsobem            
znázorněna statistická data (jedná se o relativní hodnoty) většinou geografického          
charakteru. Kartogram je jednou z nejpoužívanějších metod tematické kartografie. Metoda          
kartogramu se často kombinuje s jinými metodami, nejčastěji s metodou kartodiagramu. To            
má výhodu současné prezentace absolutních i relativních hodnot        
(http://old.gis.zcu.cz/studium/tka/Slides/kartogramy.pdf). 

Mapa hustoty zalidnění okresů ČR v roce 2011 
Vstupní data: 

● OkresyPolygony (vrstva z datové sady ArcČR 500 verze 3.3) 
 
Informaci o hustotě zalidnění v jednotlivých okresech ČR znázorníme pomocí kartogramu.  
 
Hustotu zalidnění typicky vyjadřujeme v počtech obyvatel na kilometr čtvereční. V dalším            
průběhu tvorby mapy budeme potřebovat atributový sloupec, ve kterém bude informace o            
rozloze okresu v km2 uložena. Proto jako první krok vytvoříme ve vrstvě OkresyPolygon             
atributový sloupec Plocha_km2 (otevřeme si atributovou tabulku a v Table Options zvolíme            
Add Field; bližší informace o vytvoření atributového sloupce viz kapitola Aktivní tvorba a             
editace vektorových dat, podkapitola Přidání atributového sloupce).  
 

 
Obr. 32  Přidání atributového sloupce. 

http://old.gis.zcu.cz/studium/tka/Slides/kartogramy.pdf


Následně do sloupce Plocha_km2 vypočteme plochu v kilometrech čtverečních (s využitím           
funkce Calculate Geometry; klikneme pravým tlačítkem myši nad názvem sloupce          
Plocha_km2 a zvolíme Calculate Geometry - vizte obrázek 33).  
 

 
Obr. 33 Výpočet plochy (v kilometrech čtverečních) jednotlivých okresů. 

 
V ArcMap pro tvorbu kartogramu (ale i kartodiagramu) slouží záložka Symbology ve            
vlastnostech (Properties) příslušné vrstvy. K vytvoření kartogramu následně vybereme         
možnost Quantities -> Graduated colors. 
 
Pokud chceme zobrazit v mapě informaci o hustotě zalidnění, je nejprve nutné z rozbalovací              
nabídky Value vybrat atributový sloupec s údaji o počtu obyvatel. Z dostupného popisu dat              
lze vyčíst, že sloupec POCET_OBYV obsahuje informaci o počtu obyvatel z výsledků            
Sčítání lidí, domů a bytů v roce 2011. Zvolíme tedy jako zdroj informací o počtu obyvatel v                 
jednotlivých okresech tento atributový sloupec.  
 
Abychom skutečně zobrazili informaci o hustotě (kartogram zobrazuje relativní hodnoty), je           
potřeba vyplnit hodnotu Normalization. V případě hustoty obyvatel zvolíme připravený          
sloupec Plocha_km2. 
 
Další nastavení je počet intervalů, do kterých budou nabývané hodnoty hustoty zalidnění            
rozdělené, nastavíme 6. Přes volbu Classify zobrazíme okno Classification. V okně           
Classification ještě můžeme nastavit tzv. Break Values, které ohraničují jednotlivé intervaly.           
Z důvodů zvýšení čitelnosti mapy nastavíme tyto hodnoty na celočíselné (viz obr. 34). 



 
Obr. 34 Nastavení klasifikace - volba použité metody a nastavení velikosti intervalů (Break             
Values). 
 
Nastavení kartogramu pak bude vypadat jako na obrázku 35. 
 

 
Obr. 35 Vytvoření kartogramu znázorňujícího počet obyvatel na kilometr čtvereční. 
 



Vytvoření kartogramu potvrdíme stiskem tlačítka Použít a OK. Data budou vypadat jako na             
obrázku 36. 
 

 
Obr. 36 Kartogram znázorňující hustotu zalidnění v jednotlivých okresech. 
 
Prvky mapové kompozice 
 
Pokud vytváříme tematickou mapu, musíme dát pozor, aby tato mapa obsahovala povinné            
prvky mapové kompozice. Těmi jsou: 

● mapové pole, 
● název, 
● legenda, 
● měřítko, 
● tiráž. 

Mezi další důležité prvky mapy patří směrovka. 
 
Pro vytvoření mapy obsahující všechny výše uvedené prvky je potřeba se přepnout do tzv.              
Layout View (menu View -> Layout View). Po přepnutí vypadá pracovní prostředí jako na              
obrázku 37. 
 



 
Obr. 37 Zobrazení dat po přepnutí do Layout View. 
 
Vzhledem k rozložení dat je vhodné přepnout orientaci stránky do orientace na šířku (menu              
File -> Page and Print Setup; Orientation: Landscape). Tím dojde ke změně orientace             
stránky do orientace na šířku.  
 
Abychom nové orientaci uzpůsobili i rozložení dat, klikneme na data v mapovém okně levým              
tlačítkem myši a následně pravým tlačítkem myši (nad daty v mapovém okně) a zvolíme              
Distribute -> Fit to Margins.  
 
V posledním kroku (abychom maximalizovali plochu mapy využité vlastními daty), zvolíme           
opět pravé tlačítko myši nad daty v mapovém okně a následně volbu Full Extent. Po               
provedených úpravách vypadá pracovní prostředí jako na obr. 38. 
 

 



Obr. 38 Úprava dat v Layout View. 
 
Přidání jednotlivých povinných a dalších prvků mapové kompozice se provádí přes menu            
Insert. V případě názvu a tiráže se vloží do mapy textové pole, do kterého zapíšeme               
požadované informace. Zadaný text je následně možné editovat, aby text (v případě názvu)             
byl například dobře čitelný. 
 
U směrovky v jejích vlastnostech (Properties) zvolíme její nastavení na geografický sever            
(Align To: True North), viz obr. 39. 
 

 
Obr. 39 Nastavení orientace směrovky na geografický sever. 
 
Pokud budeme chtít naši mapu vytisknout, přidáme kvůli srážce papíru grafické měřítko. Ve             
vlastnostech měřítka nastavíme jako jednotky dělení (Division Units) kilometry a za měřítko            
umístíme popisek “km” (viz obr. 40). 
 



 
Obr. 40 Nastavení grafického měřítka. 
 
Přidáním legendy nás provede průvodce Legend Wizard (dostupný přes menu Insert ->            
Legend). Pokud v jednotlivých krocích průvodce ponecháme veškerá nabídnutá nastavení,          
bude mít legenda po přidání do ArcMap podobu, jak ji znázorňuje obrázek 41 (a). Je zřejmé,                
že vytvořenou legendu bude potřeba ještě upravit. K tomu nad legendou klikneme pravým             
tlačítkem myši a zvolíme možnost Convert to Graphics a následně ještě jednou pravým             
tlačítkem myši nad legendou a možnost Ungroup. Nyní bude možné přistupovat a upravovat             
či odstranit jednotlivé elementy legendy (viz obrázek 41 (b)). 
 

  

Obr. 41 (a) Legenda tak, jak ji ve výchozím nastavení vytvoří průvodce. (b) Funkce Ungroup               
rozdělí legendu na jednotlivé elementy. 
 
Po provedených úpravách je možné všechny elementy legendy označit a přes pravé tlačítko             
myši a volbu Group sloučit do jediného prvku. Upravenou legendu ilustruje obrázek 42. 
 



 
Obr. 42 Upravená legenda. 
 
Přidání popisků 
 
Pro lepší orientaci ve vytvořené mapě přidáme do mapy ke každému okresu informaci o              
názvu příslušného okresu ve formě popisku. Názvy okresů máme dostupné v atributu            
NAZ_LAU1. Abychom zajistili, že se budou zobrazovat popisky právě z tohoto sloupce,            
otevřeme Properties a záložku Labels. V poli Label Field pak z rozbalovací nabídky             
vybereme sloupec NAZ_LAU1, viz obr. 43. Na záložce Labels je možné rovněž nastavit             
velikost popisků. 
 

 
Obr. 43 Nastavení popisků na záložce Labels. 
 
Abychom zajistili zvýšení čitelnosti v mapě, klikneme na záložce Labels na možnost            
Symbol… a následně na Edit Symbol… Otevře se nám tím okno Editor, kde klikneme na               
záložku Mask a zaškrtneme Style: Halo.  
 
Zobrazení popisků pak provedeme přes pravé tlačítko myši nad názvem vrstvy a volbou             
Label Features.  
 



Vytvořenou mapu je možné exportovat (File -> Export Map) do několika formátů (např. pdf,              
png) a ve zvoleném dpi (vyšší dpi zajistí lepší kvalitu vytištěné mapy). Vyexportovaná mapa              
je zobrazena na obr. 44. 
 

 
Obr. 44 Mapa hustoty zalidnění v okresech ČR v roce 2011. 

Mapa druhů pozemků v k.ú. Plzeň 
 
Úkol: Vytvoření mapy druhů pozemků v k.ú. Plzeň 
zdrojová data: RÚIAN (vrstvy: parcely, katastrální území), číselník SC_D_POZEMKU.csv 
 
Řešení: 

1. Z vrstvy katastrálních území vybereme (atributovým dotazem: Selection -> Select by 
Attributes…) katastrální území Plzeň. 

2. Z vrstvy parcel vybereme (prostorovým dotazem: Selection -> Select by Location...) 
pouze parcely ležící v k.ú. Plzeň. 

 



 
Obr. 45 Prostorový výběr parcel ležících v k.ú. Plzeň. 
 

3. K parcelám připojíme (pravé tlačítko myši nad vrstvou parcel obsahující parcely v k.ú.             
Plzeň -> Joins and Relates a Join…) z číselníku textovou informaci o druhu             
pozemku. 



 
Obr. 46 Připojení informací o druhu pozemku k vrstvě parcel ležících v k.ú. Plzeň. 
 

4. Vytvoříme tematickou mapu znázorňující druhy pozemků v k.ú. Plzeň (viz obr. 47). 
(Nápověda: vizte kapitolu Tvorba základní mapové symboliky) 

 



 
Obr. 47 Mapa druhů pozemků v k.ú. Plzeň 

Aktivní tvorba a editace vektorových dat 
Cílem této kapitoly je ukázat, jak vytvořit novou vrstvu (ve formátu shapefile) a jak naplnit               
tuto vrstvu vektorovými daty včetně atributů. Jako podkladová data použijeme výřez           
naskenovaného mapového listu III. Vojenského mapování (viz obr. 48). 
 



 
Obr. 48 Výřez mapového listu III. Vojenského mapování 

Tvorba nové vrstvy v ArcCatalog 
ArcGIS nabízí pro tvorbu nové vrstvy software ArcCatalog. Pro založení nového shapefile je             
potřeba v Catalog Tree označit (levým tlačítkem myši) adresář, do kterého chceme shapefile             
vytvořit. Následně nad názvem tohoto cílového adresáře klikneme pravým tlačítkem myši a            
zvolíme New -> Shapefile… Případně po výběru adresáře pro vytvoření nového shapefile            
zvolíme menu File -> New -> Shapefile…Tím se nám zobrazí okno jako na obr. 49. 
 

 
Obr. 49 Založení nového shapefile v ArcCatalog. 
 



V poli “Name” zadáme název nové vrstvy. Předpokládejme, že v tuto chvíli chceme vytvořit              
novou vrstvu, do které budeme přidávat (vektorizovat) vrstevnice z naskenovaného          
mapového listu III. Vojenského mapování. Do pole pro název tedy zapíšeme “Vrstevnice”. 
 
Jednotlivé vrstevnice budou v nové vrstvě reprezentovány liniemi. Z rozbalovací nabídky           
“Feature Type” tedy zvolíme hodnotu “Polyline”. Kromě toho nabízí ArcCatalog ještě tyto            
možnosti: 

● Point (pro bodová data) 
● Polygon (pro polygonová data) 
● MultiPoint (pro množinu bodů se shodnými atributy) 
● MultiPatch (pro 3D objekty) 

 
V části “Spatial Reference” nastavíme souřadnicový systém. Po stisknutí tlačítka “Edit” se            
nám otevře okno “Spatial Reference Properties”, ve kterém vyhledáme požadovaný          
souřadnicový systém. V našem případě nastavíme “S-JTSK Krovak EastNorth”. 
 

 
Obr. 50 Vytvoření nové vrstvy Vrstevnice v souřadnicovém systému S-JTSK. 
 
Zaškrtnutím volby “Show Details” (nepovinné) si můžeme nechat vypsat detailní informace o            
nastaveném souřadnicovém systému. Pokud by shapefile obsahoval linie reprezentující         
routovatelná data, zašrtli bychom volbu “Coordinates will contain M values. Used to store             
route data”. Pokud by shapefile obsahoval trojrozměrná data, zaškrtli bychom volbu           
“Coordinates will contain Z values. Used to store 3D data”. 
 
Po vytvoření vrstvy můžeme v ArcCatalog vyplnit metadata. Vybereme vrstvu, pro kterou            
chceme metadata vytvořit a na záložce “Description” se nám po stisku “Edit” zpřístupní             
jednotlivé metadatové položky pro zápis . 3

3 Nastavení stylu pro metadata je možné provést v ArcCatalog Options (menu Customize ->              
ArcCatalog Options…). Na záložce “Metadata” můžeme zvolit požadovaný styl (např. INSPIRE či ISO             
19139). 



 
Na obrázku 51 můžeme vidět příklad metadat vyplněných pro vrstvu vrstevnic 
 

 
Obr. 51 Dialog pro vyplnění metadat  

Vektorizace v ArcMap 
Pro přidání prvků do nově vytvořené vrstvy (shapefile Vrstevnice) si tuto vrstvu načteme do              
ArcMap a otevřeme si panel nástrojů Editor (menu Customize -> Toolbars -> Editor).  
 
Poznámka: Pokud do ArcMap načtete nejprve georeferencovaný rastr s výřezem mapy III.            
Vojenského mapování a až poté nově vytvořenou vrstvu (shapefile), nemusí být výřez mapy             
viditelný. V takovém případě zvolte pravé tlačítko myši nad rastrem v Table of Contents ->               
Zoom To Layer.  
 
Editaci zahájíme přes Editor -> Start Editing. Pozor - pokud máme v ArcMap načteno více               
vrstev, které je teoreticky možné editovat, musíme správně zvolit vrstvu, kterou chceme            
doopravdy editovat.  
 
Ještě než začneme vytvářet nové prvky (nyní vrstevnice), nastavíme si tzv. snapping,            
abychom vytvářeli topologicky čistá data. Snapping je vhodné nastavit pro každou vrstvu            
zvlášť, abychom nastavili pouze to, co je potřeba. Panel nástrojů Snapping si otevřeme přes              
Editor -> Snapping -> Snapping Toolbar.  
 



V případě vrstevnice budeme požadovat, aby byl koncový uzel vrstevnice identický s            
počátečním uzlem. Na panelu nástrojů Snapping tedy zvolíme End Snapping (přichytávání           
se na počáteční nebo koncový uzel linie, viz obr. 52). Kromě toho můžeme ještě nastavit tyto                
možnosti: 
 

● Point Snapping. Přichytávání se na bodovou geometrii.  
● Vertex Snapping. Přichytávání se na mezilehlé vrcholy. 
● Edge Snapping. Přichytávání se na linie či hranice polygonů. 

 

 
Obr. 52 Panel nástrojů Snapping s nastavením End Snapping. 
 
Poslední nastavení, které provedeme na panelu nástrojů Snapping, je zaškrtnutí volby Snap            
To Sketch (Snapping -> Snap To Sketch). Toto nastavení nám umožní využít snapping pro              
dočasnou (doposud neuloženou) kresbu. Pokud budeme například vytvářet novou vrstevnici,          
která není prozatím v datech uložena, umožní nám tato volba přichytit se na počáteční uzel               
kresby vytvářené vrstevnice.  
 
Pro vytvoření nového prvku slouží funkce Create Features. Při vektorizaci volíme jednotlivé            
vrcholy tak, aby vznikající vektorová kresba nevybočovala z prvku vyznačeného ve           
zdrojovém rastru (viz obr. 53). V případě, že vektorizujeme liniový prvek (např. vrstevnici) a              
máme nastavený snapping (End Snapping), můžeme se v posledním kroku vektorizace           
přichytit kurzorem myši na počáteční bod. Následně ukončíme vektorizaci prvku volbou           
Finish Sketch (přes pravé tlačítko myši nad zvektorizovaným prvkem a volbou Finish Sketch,             
případně stiskem klávesy F2).  
 

 
Obr. 53 Zvektorizovaná vrstevnice. 
 
Vektorizaci uložíme přes Editor -> Save Edits. 
 
Přidání atributového sloupce 
 
Vytvořením nové vrstvy v ArcCatalog automaticky vznikne i odpovídající soubor *.dbf, který            
slouží pro uložení atributových dat (atributové tabulky). Ve výchozím stavu se v tabulce             
vytvoří pouze sloupce FID, Shape a Id. Při vektorizaci budeme často chtít kromě vytvoření              
prostorových dat vytvářet (resp. ukládat v atributové tabulce) i odpovídající atributová data.            



V případě vrstevnic to např. bude údaj o nadmořské výšce. Abychom mohli přidat nový              
sloupec, otevřeme si atributovou tabulku a v Table Options zvolíme Add Field (pokud by tato               
volba byla neaktivní, musíme ukončit editovací režim). Vyplníme název sloupce, vhodný           
datový typ a případně počet desetinných míst (viz obr. 54). 
 

 
Obr. 54 Přidání atributového sloupce.  
 
Abychom mohli vepsat do nově přidaného sloupce hodnotu, je potřeba znovu pustit režim             
editování. Na mapách III. Vojenského mapování jsou rozestupy vrstevnic 20 metrů, tučně            
vyznačené vrstevnice jsou pak celočíselnými násobky sta. Zvektorizovaná vrstevnice na obr.           
53 tak bude mít hodnotu 500, kterou zapíšeme do atributové tabulky.  
 
Vektorizace bodové vrstvy 
 
Pokud budeme chtít vytvořit vrstvu, do které budeme ukládat prvky reprezentované bodovou            
geometrií, postupujeme při vytvoření vrstvy stejně jako v předchozím případě, pouze           
hodnotu Feature Type zvolíme Point. Body mohou být reprezentovány například kóty. Na            
obr. 55 jsou zobrazeny zvektorizované kóty s vyplněnou hodnotou atributu Vyska. 
 



 
Obr. 55 Zvektorizované kóty v mapovém listu III. Vojenského mapování. 
 
Vektorizace polygonové vrstvy 
 
Polygony mohou být reprezentovány například stavby, či vodní plochy. Při vytváření nové            
vrstvy zvolíme u Feature Type hodnotu Polygon.  
 
Při vektorizaci polygonového prvku neukončujeme vektorizaci opětovným kliknutím na         
počáteční bod, jako tomu bylo například u uzavřené linie, ale zvolíme pravé tlačítko myši a               
volbu Finish Sketch. Spojnici prvního bodu a předposledního bodu ArcMap automaticky           
doplní. Obr. 56 zobrazuje několik zvektorizovaných staveb. 
 

 
Obr. 56 Zvektorizované stavby v mapovém listu III. Vojenského mapování. 
 
Editace geometrie  
 
Předpokládejme, že dojde k tomu, že bude potřeba editovat vytvořená vektorová data, např.             
opravit chybně vektorizovaný prvek, viz obr. 57. 



 
Obr. 57 Chybně (v horní části obrázku) vektorizovaná vrstevnice. 
 
Pro opravu vektorové kresby lze využít nástroj Edit Tool z panelu nástrojů Editor. Zvolíme              
použití tohoto nástroje a následně levým tlačítkem myši klikneme na prvek, který chceme             
editovat. Dále klikneme pravým tlačítkem myši a zvolíme Edit Vertices. Vybraný prvek bude             
nyní vypadat jako na obrázku 58. 
 

 
Obr. 58 Vybraný prvek, který chceme editovat. Zeleně jsou označené jednotlivé vrcholy. 
 
Pokud budeme chtít na konkrétní úsek (mezi dvěma vrcholy) vložit nový bod, klikneme             
pravým tlačítkem myši nad tímto úsekem a zvolíme Insert Vertex. Nově vložený vrchol pak              
můžeme posunout na námi požadovanou pozici, aby došlo ke zlepšení geometrie prvku.            
Uvedený postup lze opakovat, abychom dosáhli potřebné přesnosti geometrie. Obr. 59           
ukazuje opravenou vrstevnici se dvěma nově vloženými vrcholy. 
 



 
Obr. 59 Editovaná vrstevnice s dvěma nově přidanými vrcholy. 
 
Pokud bychom chtěli naopak smazat vrchol, vybereme nejprve prvek k editaci (Edit            
Vertices), dále klikneme na vrchol, který chceme odstranit a stiskneme pravé tlačítko myši a              
Delete Vertex.  
 
Uvedený postup editace liniové vektorové kresby platí i pro polygonová data. 

Základní dotazování a analýzy 
vektorových dat 
Použitá data: 

● ArcČR 500 verze 3.3, vrstvy: 
○ KrajePolygony 
○ Lesy 
○ OkresyPolygon 
○ SidlaBody 
○ Silnice_2016  
○ VodniPlochy 
○ Zeleznice 

 
+ pdf soubor ArcCR_500-3.3-Popis-dat.pdf (popis jednotlivých vrstev a jejich         4

atributů).  
 
 

4 http://download.arcdata.cz/data/ArcCR_500-3.3-Popis-dat.pdf (dostupné 24. 7. 2017). 



Atributové dotazy 
Geografická data obsahují atributovou a prostorovou složku. Pokud vybíráme data na           
základě hodnoty atributu (nebo hodnot více atributů), hovoříme o atributových dotazech. 
 
Úloha č. 1: Vyberte všechny dálnice. 
 
Tento dotaz je již řešen v kapitole Mapa závislá na měřítku. V té jsme vzali řešení daného                 
dotazu pouze na vědomí, nyní se podíváme na jeho řešení detailněji. 
 
V ArcMap jsou atributové dotazy realizovány pomocí okna Select by Attributes (Selection ->             
Select by Attributes…; viz obr. 60).  
 

 
Obr. 60 Okno Select by Attributes. 
 
V Layer nastavíme vrstvu, ze které chceme vybírat data. V našem případě z rozbalovací              
nabídky zvolíme vrstvu Silnice_2016.  
 
U metody výběru (Method) máme na výběr celkem ze 4 metod: 

● Create a new selection. Vytvoření nového výběru. 
● Add to current selection. Přidání prvků k aktuálnímu výběru. 
● Remove from current selection. Odebrání prvků z aktuálního výběru. 
● Select from current selection. Vybrání prvků z aktuálního výběru. 

 



Protože vytváříme nový výběr (nemáme aktuálně vybrány žádné prvky ve vrstvě           
Silnice_2016), zvolíme metodu “Create a new selection”. 
 
Zbývá nám zadat, že se mají vybrat pouze prvky, které reprezentují dálnice. Tuto podmínku              
je potřeba zapsat do textového pole a doplnit tak dotaz zapsaný v jazyce SQL (Structured               
Query Language) 'SELECT * FROM vrstva WHERE:'. 
 
Víme, že se musíme dotazovat na sloupec 'TRIDA'. Proto na tento sloupec v dialogovém              
okně klikneme a název sloupce se nám přidá do textového pole. Ze znamének vybereme '=',               
neboť se dotazujeme na rovnost atributu nějaké hodnotě. Konkrétně v tomto příkladě            
hodnotě '1'. Tuto hodnotu je možné zapsat ručně z klávesnice, případně kliknout na tlačítko              
'Get Unique Values' a vybrat hodnotu z unikátních hodnot. 
 
Kompletní atributový dotaz pro vybrání všech dálnic pak bude vypadat jako na obr. 61.  

 

 
Obr. 61 Vybrání všech dálnic z vrstvy Silnice_2016. 
 
Po stisku tlačítka “Apply” dojde k vybrání všech dálnic. Celkem se vybere 298 prvků, jedna               
dálnice je tedy v datech evidentně složena z více úseků, např. D5 je složena z 21 úseků                 
(zkuste si samostatně ověřit pomocí atributového dotazu a použitím metody “Select from            
current selection”). Pokud otevřeme atributovou tabulku u vrstvy Silnice_2016, můžeme si           
tlačítkem “Show selected records” zobrazit pouze vybrané záznamy. Naopak ikona “Switch           
Selection” provede prohození výběru, tedy vybere všechny prvky, které nejsou dálnicí. 
 



Pokud bychom některý dotaz zadávali častěji, je možné si jej pomocí tlačítka “Save…” uložit              
a příště pomocí “Load… načíst” a opětovně spustit.  
 
Zrušení výběru provedeme přes Selection -> Clear Selected Features. 
 
Úloha č. 2: Vyberte všechny silnice 1. třídy, které mají čtyři jízdní pruhy. 
 
Opět budeme pracovat s vrstvou Silnice_2016. Informace o tom, zda je komunikace silnicí 1.              
třídy, je uložena v atributu “TRIDA”, informaci o počtu jízdních pruhů najdeme v atributu              
“PRUHY”.  
 
Při řešení tohoto atributového dotazu můžeme s výhodou použít logickou spojku “And”. To             
znamená, že podmínka pro výběr prvků zahrne jak požadavek, aby se vybraly pouze silnice              
1. třídy, tak současně zohlední požadavek, aby vybrané silnice 1. třídy měly čtyři jízdní              
pruhy. Celý dotaz pak vypadá jako na obr. 62. 
 

 
Obr. 62 Vybrání všech silnic 1. třídy, které mají čtyři jízdní pruhy. 
 
Celkem se vybralo 334 záznamů.  
 
Zkuste si rovněž dotaz vyřešit tak, abyste použili metody “Select from current selection”. V              
obou případech musíte získat shodný výsledek. 
 
Atributové dotazy k procvičení 



 
Úloha č. 3: Vyberte všechny elektrifikované vnitrostátní dvoukolejné železniční tratě. 
[Výsledek: 43] 
 
Úloha č. 4: V kolika okresech ČR žilo k 1. 1. 2016 více jak 100 tisíc a méně než 150 tisíc                     
obyvatel? 
[Výsledek: 30] 

Prostorové dotazy 
Pokud vybíráme data z více vrstev na základě jejich prostorového vztahu, hovoříme o             
prostorových dotazech. 
 
Úloha č. 5: Kolik železnic prochází lesem? 
 
V tomto případě budeme vybírat železnice (reprezentované liniemi), které se kříží/protínají           
(intersect) s lesy (reprezentované polygony). Pokud se tedy (stačí část) linie reprezentující            
určitou železniční trať protíná s alespoň jedním polygonem reprezentující les, bude tato linie             
(železniční trať) vybrána. 
 
V ArcMap jsou prostorové dotazy realizovány pomocí okna Select by Location (Selection ->             
Select by Location…; viz obr. 63).  
 

 



Obr. 63 Okno Select by Location. 
 
U metody výběru (Selection method) máme na výběr celkem ze 4 metod: 
 

● Select features from. Vytvoření nového výběru. 
● Add to the currently selected features in. Přidání prvků k aktuálnímu výběru. 
● Remove from the currently selected features in. Odebrání prvků z aktuálního           

výběru. 
● Select from the currently selected features in. Vybrání prvků z aktuálního výběru.  

 
Protože vytváříme nový výběr (nemáme aktuálně vybrány žádné prvky ve vrstvě Zeleznice),            
zvolíme metodu “select features from”. 
 
Vybíráme data z vrstvy Zeleznice, u volby “Target layer(s)” proto zaškrtneme Zeleznice.            
Jednotlivé železnice budou testovány na splnění konkrétního prostorového vztahu oproti          
prvkům z vrstvy Lesy, u volby “Source layer” proto zvolíme vrstvu Lesy. 
 
Nastavení prostorového vztahu se provede ve volbě “Spatial selection method for target            
layer feature(s)”. ArcMap nabízí např. tyto prostorové vztahy : 5

 
● intersect the source layer feature - kříží/protíná 
● are within distance of the source layer feature - jsou ve (do) vzdálenosti (včetně) 
● contain the source layer feature - obsahují 
● completely contain the source layer feature - úplně obsahují 
● are within the source layer feature - jsou uvnitř 
● are completely within the source layer feature - jsou kompletně obsaženy 
● are identical to the source layer feature - jsou identické s 
● touch the boundary of the source layer feature - dotýkají se hranice 
● share a line segment with the source layer feature - sdílejí liniový segment s 
● are crossed by the outline of the source layer feature - jsou překříženy obrysem 
● have their centroid in the source layer feature - mají svůj střed v 

 
V tomto konkrétním dotazu, jak už bylo uvedeno výše, zvolíme typ prostorového vztahu             
“intersect”. Sestavený prostorový dotaz vyhledávající všechny železnice procházející lesem         
pak bude vypadat jako na obr. 64. 
 

5 Vyčerpávající vysvětlení k nabízeným typům prostorových vztahů lze nalézt kliknutím na odkaz 
“About select by location” v dialogu vlevo dole (viz obr. 64). 

http://desktop.arcgis.com/en/arcmap/latest/map/working-with-layers/using-select-by-location.htm


 
Obr. 64 Prostorový dotaz, který vybere všechny železnice procházející lesem. 
 
Dotaz necháme provést stiskem tlačítka “Apply”. Celkem bude z vrstvy Zeleznice vybráno 1             
154 záznamů. 
 
Úloha č. 6: Kolik sídel leží ve vzdálenosti větší jak 5 km od železnice? 
 
Důležité: Při vyhodnocování prostorového dotazu, při kterém se uvažuje vzájemná          
vzdálenost prvků z různých vrstev, ArcMap musí vědět, v jakých jednotkách měřit, to             
znamená, musí být nastavený souřadnicový systém. Pokud by se informace o           
souřadnicovém systému nepřevzala z první načtené vrstvy, lze v ArcMap nastavit           
souřadnicový systém přes: View -> Data Frame Properties... Dále zvolíme (pro S-JTSK):            
Projected Coordinate Systems -> National Grids -> S-JTSK Krovak EastNorth. 
 
Při vyhodnocení prostorového dotazu můžeme postupovat tak, že nejdříve vybereme          
všechna sídla, která jsou ve vzdálenosti do 5 km od železnice (viz obr. 65) a poté                
invertujeme výběr. 
 



Pro výběr sídel na základě podmínky vzdálenosti použijeme prostorový vztah “are within            
distance of the source layer feature”.  
 

 
Obr. 65 Vybrání všech sídel, která jsou ve vzdálenosti do 5 km od železnice. 
 
Invertování výběru pak provedeme v atributové tabulce pomocí ikony “Switch Selection”. 
 
Po provedení všech výše provedených kroků se vybere 751 měst. 

Kombinace atributových a prostorových dotazů 
Při praktických úlohách často narazíme na situaci, kdy k vyřešení potřebujeme použít            
atributový i prostorový dotaz (případně více atributových a prostorových dotazů).  
 
Úloha č. 7: Najděte všechna sídla ležící ve vzdálenosti do 5 km od dálnice. 
 
 
Možných řešení zadané úlohy je jistě více. Efektivním řešením je rozložit úlohu na dva              
dotazy: 

1. Nejprve provést atributový dotaz nad vrstvou Silnice_2016 a vybrat z ní všechny            
dálnice. 

2. Následně prostorovým dotazem vybrat všechna sídla do 5 km od dálnic. 
 



Atributový dotaz pro vybrání dálnic byl ukázán v úloze 1. 
Prostorový dotaz pro vybrání sídel do 5 km od dálnice pak bude vypadat následovně: 
 

 
Obr. 66 Vybrání sídel do 5 km od dálnice. Všimněte si, že je potřeba zaškrtnout volbu “Use                 
selected features”. Tato volba je zaškrtnuta z toho důvodu, aby se při testování prostorového              
vztahu (ve vzdálenosti do 5 km) uvažovaly pouze vybrané prvky z vrstvy Silnice_2016, tedy              
dálnice. 
 
Jako výsledek dostaneme 1 488 sídel. 
 
Úlohy k procvičení 
 
Úloha č. 8: Kolik sídel leží v okrese Klatovy? 
[Výsledek: 45] 
 
Úloha č. 9: Kolik lázeňských sídel leží do 1 km od lesa? 
[Výsledek: 21] 

Topologické překrytí 
Obecně dotazování dvou nebo více informačních vrstev se označuje jako topologické           
překrytí (overlay) těchto vrstev. Klasicky se tento problém řešil překrytím dvou tématických            



map na průhledných fóliích. Stejný problém se v GIS řeší pomocí základních algoritmů             
počítačové grafiky (test bodu v polygonu, hledání průsečíku dvou objektů, ořezávání).           
Výsledkem postupu je pak identifikace nových objektů, které mají kombinace vlastností           
objektů ze zdrojových informačních vrstev. Pro kombinaci vstupních objektů se opět (jako u             
atributových a prostorových dotazů) používají pravidla Booleovské logiky.  

Základní operace topologického překrytí 
Systémy obvykle nabízejí: 

● IDENTITY (přiřazení na základě prostorového umístění – rozřeže vstupní vrstvu          
podle hranic v překryvné vrstvě). 

● INTERSECT (AND – průnik – výsledek obsahuje všechny části prvků z obou vrstev,             
které se překrývají),  

● Symmetrical difference (symetrický rozdíl – výsledek obsahuje všechny části prvků z           
obou vrstev, které nejsou v jejich průniku) 

● UNION (OR – sjednocení – výsledek obsahuje všechny vstupní prvky, rozřezané na            
části podle hranic v obou stupních vrstvách).  

 
 

 
Obr. 67 Princip fungování topologického překrytí (zdroj: ArcGIS 10.5 Help). 
 
Při těchto operacích dochází k řešení vztahů bod, linie nebo polygon v polygonu . Z procesu               6

topologického překrytí vznikají nové objekty (vrstvy), kterým jsou přiřazeny také atributy. Tím            
se topologická překrytí liší od prostorových dotazů, kde žádné nové vrstvy nevznikají. 

6 podrobnosti zde: 
http://desktop.arcgis.com/en/arcmap/latest/analyze/commonly-used-tools/overlay-analysis.htm v 
kapitole “Vector overlay tools”. 

http://desktop.arcgis.com/en/arcmap/latest/analyze/commonly-used-tools/overlay-analysis.htm


Další operace využitelné při topologickém překrývání 
Mimo výše zmíněných základních funkcí lze při topologickém překrývání vrstev pracovat i s             
operátory, jako jsou clip (oříznutí), erase (vymazání), update (aktualizace/záměna) a split           
(rozřezání), viz obr 68. Tyto operace na rozdíl od základních operací k vstupní vrstvě              
nepřidávají atributy z překryvné vrstvy. 

 
Obr. 68. Clip (oříznutí), erase (vymazání), update (aktualizace/záměna) a split (rozřezání). 
 
Úloha č. 10: Najděte všechny úseky železnic, které procházejí lesem. 
 
Tato úloha je svým zadáním podobná úloze č. 5. Řešením úlohy č. 5 pak byly všechny                
železnice, které procházejí lesem, přičemž stačilo, aby jen nepatrný kus železnice ležel v             
lese a tato železnice byla vybrána jako celek. Úloha č. 10 je myšlena odlišně - zajímají nás                 
pouze takové úseky železnic, které skutečně leží v lese. 
 
Úlohu vyřešíme pomocí topologického překrytí, přičemž použijeme operátor INTERSECT.         
Najdeme jej v ArcToolbox -> Analysis Tools -> Overlay -> Intersect (viz obr. 69). 
 



  
Obr. 69 Spuštění topologického překrytí z ArcToolbox 
 
V otevřeném okně pro topologické překrytí (operátor INTERSECT) vybereme vrstvy, mezi           
kterými bude topologické překrytí probíhat, tedy Zeleznice a Lesy a protože při topologickém             
překrytí vzniká nová vrstva, nastavíme cestu pro tuto novou vrstvu (viz obr. 70).  
 

 



 
Obr. 70 Nastavení topologického překrytí - použití operátoru INTERSECT. 
 
Výsledkem topologického překrytí je pak vrstva, která obsahuje pouze ty části železnic, které             
se nacházejí v lese (viz obr. 71). 
 



 
Obr. 71 Úseky železnic, které se nacházejí v lese (zvýrazněné tučně červenou barvou). 
 
Úloha č. 11 Najděte všechny úseky železnic, které neprocházejí lesem. 
 
Na rozdíl od úlohy č. 10 máme tentokrát za úkol najít takové úseky železnic, které               
neprocházejí lesem. Potřebujeme tedy rozdělit úseky železnic tak, abychom pro každý úsek            
měli informaci o tom, zda lesem prochází či nikoli a následně jsme vybrali pouze takové               
úseky, které lesem neprochází. K tomu se hodí použít topologické překrytí s operátorem             
IDENTITY. Vstupní vrstvou bude vrstva železnic a překrývající vrstvou pak vrstva lesů (viz             
obr. 72).  
 

 
Obr. 72 Nastavení topologického překrytí - použití operátoru IDENTITY. 
 
Pokud úsek železnice procházel lesem, je v nově vzniklé vrstvě u tohoto úseku uložený i               
identifikátor (FID_Lesy) daného lesa. V opačném případě, pokud úsek v lese neležel, je u              



záznamu v nové vrstvě hodnota atributu FID_Lesy rovna hodnotě -1. Zbývajícím krokem pro             
vyřešení úlohy je tedy najít všechny takovéto záznamy (viz obr. 73). 

 

 
Obr. 73 Vyhledání železnic, které neleží v lese. 
 

 
Obr. 74 Vizualizace železnic (zvýrazněné tyrkysovou barvou), které neleží v lese. 
 
 



Úloha č. 12 Který okres má nejvíce zalesněné plochy? 
 
Ukážeme si řešení tohoto zadání pomocí topologického překrytí s využitím operátoru           
UNION.  
 

 
Obr. 75 Nastavení topologického překrytí - použití operátoru UNION. 

 
Vrstva okresy, která vstupovala do topologického překrytí, pokrývá celé území ČR. Po            
provedení topologického překrytí s využitím operátoru UNION obsahuje část záznamů v           
nově vzniklé vrstvě v atributu FID_Okresy hodnotu -1. Tyto části lesů tedy leží mimo okresy               
(respektive hranice ČR). 
 
Záznamy s hodnotou atributu FID_Lesy rovno -1 jsou zase takové, kde se na území okresu               
nenachází žádný les.  
 
Pro každý záznam v nově vytvořené vrstvě bude potřeba vypočítat plochu, kterou daný             
prvek zaujímá. Přidáme nový atributový sloupec (Name: Plocha, Type: Long Integer) a do             
něj pomocí funkce Calculate Geometry plochu (například v hektarech) vypočítáme (přes           
pravé tlačítko myši nad názvem sloupce a volbu Calculate Geometry…). 
 
Pro další postup vybereme z nově vzniklé vrstvy pouze ty záznamy, které odpovídají částem              
okresů, na jejichž území se nachází les . Postupovat můžeme tak, že nejprve atributovým             7

dotazem vybereme všechny záznamy, které splňují podmínku “FID_Okresy = -1 OR           
FID_Lesy = -1” a následně v atributové tabulce prohodíme výběr (switch selection), případně             
při konstrukci dotazu použijeme operátor <>.  

7 Vybrání částí okresů, na jejichž území se nachází les, bychom docílili rovnou s použitím               
topologického překrytí a použití operátu INTERSECT. Cílem je zde ukázat, jak se jednotlivé operátory              
při topologickém překrytí chovají a na co si při jejich použití dát pozor. 



 
Abychom zjistili, jaký okres obsahuje nejvíce zalesněné plochy, ponecháme si otevřenou           
atributovou tabulku (ve které nyní máme aktivně vybrané pouze záznamy odpovídající           
částem okresů pokrytých lesy) a použijeme funkci Summarize. Tato funkce vytvoří novou            
tabulku obsahující jeden záznam pro každou unikátní hodnotu ze zvoleného atributu           
(sloupce) a spolu s tím zde bude uložena statistika údajů z ostatních vybraných polí.  
 
Kód okresu je uložený v atributu KOD_LAU1. Přes pravé tlačítko myši nad názvem tohoto              
sloupce vyvoláme nabídku a následně zvolíme funkci Summarize.... Objeví se okno jako na             
obrázku 76. U sloupce “plocha” (sloupec s vypočtenou plochou jednotlivých prvků)           
zaškrtneme volbu “Sum” . Tím dojde k součtu všech ploch pro příslušný okres. Nastavíme             8

cestu pro uložení tabulky (uložíme ji ve formátu dBASE Table) a zkontrolujeme, že máme              
zaškrtlou volbu “Summarize on the selected records only” (tato volba zajišťuje, že se uvažují              
pouze vybrané záznamy). Po vyplnění okna Summarize potvrdíme stiskem tlačítka OK, čímž            
dojde k vytvoření žádaného přehledu ve formě tabulky. Po jejím vytvoření nám ArcMap             
nabídne tuto tabulku přidat do Table of Contents.  
 

 
Obr. 76 Okno Summarize 

 

8 Pokud bychom chtěli pouze zjistit četnost každé hodnoty v daném poli (v tomto případě v poli                 
KOD_LAU1), pouze bychom zvolili, kam se má výstupní tabulka uložit a žádné další nastavení už               
není potřeba dělat. 



Pokud v Table of Contents klikneme pravým tlačítkem myši na vytvořenou tabulku a zvolíme              
možnost Open, otevře se nám tabulka s požadovanými údaji. Přes pravé tlačítko myši nad              
sloupcem se součty ploch a volbu Sort Descening (seřazení sestupně) necháme seřadit            
jednotlivé okresy tak, že ten, který obsahuje největší plochu zalesnění, bude vypsán jako             
první (jeho kód KOD_LAU1) atd. Pokud následně vyhledáme (např. pomocí atributového           
dotazu) ve vrstvě Okresy příslušný okres, zjistíme, že výsledkem je okres Klatovy s plochou              
lesa 88694 hektarů. 
 
Pro nalezení názvu okresu můžeme rovněž vytvořenou tabulku připojit k vrstvě Okresy            
(pravé tlačítko myši nad vrstvou Okresy -> Joins and Relates -> Join…): 
 

.  
Obr. 77 Připojení vytvořené tabulky k vrstvě Okresy. 

 
V atributové tabulce vrstvy Okresy pak necháme seřadit záznamy podle sloupce           
“Sum_Plocha” a snadno již zjistíme název příslušného okresu (Klatovy). 
 
Úloha č. 13 Který okres obsahuje nejvíce lázeňských měst? 



[Výsledek: okresy Cheb a Teplice - 3 lázeňská města] 

Obalová zóna, základní vzdálenostní analýza 
Při topologickém překrytí, obdobně jako u prostorových dotazů, se používá i funkce Obalová             
zóna (Buffer). Zatímco u prostorového dotazu se zadává jako jeden z parametrů dotazu             
(Volba Apply a search distance), u topologického překrytí je potřeba pro jeho vytvoření volat              
funkci z ArcToolbox / Analysis Tools / Proximity / Buffer. 
 
Úloha č. 14 Ve kterém kraji je nejvíce rybníků ležících (touch the boundary) u lesa a                
zároveň do 5 km od železnice (použijte buffer kolem železnic)?  
[Výsledek: Jihočeský kraj, 87] 
 
Úloha č. 15 Vypište okresy, které jsou z více jak poloviny pokryté lesem. 
[výzva - kdo první spočte, dejte vědět ;-) ] 
 

 
Obr. 78 Okresy, které jsou z více jak poloviny pokryté lesy. 

Základní zpracování a analýzy 
mozaikových dat 

Georeferencování 
Georeferencování je proces výpočtu transformačních koeficientů mezi polohou v lokálním          
souřadnicovém systému a jejich polohou v rovinném souřadnicovém systému vztaženém k           
Zemi ~ v souřadnicovém systému mapy.. Georeferencování můžeme uplatnit například v           
případě, kdy naskenujeme mapový podklad, který je pak lokalizován v souřadnicovém           
systému skeneru a chceme jej přitom zkombinovat s daty v našem GIS vyjádřenými v              
konkrétním souřadnicovém systému (např. S-JTSK). Z pohledu geometrických transformací         
jde o transformaci souřadnic v rovině.  
 



Ačkoli je georeferencování většinou potřeba provést pro rastrová data, georeferencovat lze i            
vektory. Georeferencování rastrových dat je v ArcGIS realizováno sadou nástrojů          
sdružených v panelu Georeferencing (jeho použití je podrobně popsáno níže). Pro           
georeferencování vektorů lze použít nástroj analogicky fungující panel Spatial Adjustment. 
 
Zdrojová data: 

● Výřez geologické mapy (rastr) v měřítku 1:500 000 pro Plzeňský kraj (zdroj: 
https://mapy.geology.cz/geocr500/ ; přistupováno 16. 8. 2017) 

● Vektorová vrstva KrajePolygony z datové sady ArcČR 500 verze 3.3 
 
Naším úkolem bude georeferencovat výřez geologické mapy, abychom jej mohli          
zkombinovat s dalšími vrstvami v S-JTSK. Použitý rastrový výřez geologické mapy a            
vektorová vrstva obsahující hranice krajů mají ekvivalentní měřítko, takže při          
georeferencování nedojde ke ztrátě přesnosti z důvodu příliš rozdílných měřítek.  
 
Obr. 79 zobrazuje zdrojový výřez geologické mapy. 
 

 
Obr. 79 Výřez geologické mapy pro Plzeňský kraj. 
 
Georeferencování se v ArcMap provádí pomocí panelu nástrojů Georeferencing (Customize          
-> Toolbars; viz obr. 80). 
 

 
Obr. 80 Panel nástrojů Georeferencing. 
 
Dříve, než začneme s georeferencováním (resp. volbou identických bodů), na panelu           
nástrojů Georeferencing klikneme na rozbalovací nabídku Georeferencing a následně         
odškrtneme volbu Auto Adjust. Pokud bychom ji nechali aktivní, ArcMap by po každé zadané              
dvojici identických bodů automaticky aktualizoval prováděnou transformaci. 
 

https://mapy.geology.cz/geocr500/


Pro georeferencování použijeme afinní transformaci (polynomická transformace prvního        
řádu). Geometricky se tedy jedná o posun, rotaci a změnu měřítka v obou souřadnicových              
osách. Pro tento typ transformace jsou potřeba minimálně 3 dvojice identických bodů. 
 
Volba a zadání identických bodů 
 
Identické body by měly být co nejjednoznačněji identifikovatelné v obou souřadnicových           
soustavách (zdrojové i cílové) a voleny tak, aby byly rovnoměrně rozmístěné při okrajích             
transformovaného území. Při zadávání dvojic identických bodů při georeferencování v          
ArcMap rovněž musíme dát pozor na to, abychom dodrželi pořadí zadávání bodů - tedy              
nejprve vždy bod ve zdrojové souřadnicové soustavě a následně odpovídající bod v cílové             
souřadnicové soustavě (v našem případě S-JTSK). 
 

Pro zadání identických bodů slouží ikona Add Control Points  .  
 
Tip: Pokud si na panelu nástrojů Snapping zvolíme Edge Snapping, umožní nám to při              
zadávání identických bodů v cílové souřadnicové soustavě přichytávat se na vektorovou           
kresbu hranic krajů, což nám pomůže zpřesnit transformaci. 
 
Tip: Protože jsou zdrojová data v různých souřadnicových soustavách, neuvidíme je v            
mapovém okně najednou. Při zadávání identických bodů můžeme v Table of Content vždy             
kliknout pravým tlačítkem myši nad vrstvou, na kterou se potřebujeme přiblížit a zvolit Zoom              
To Layer.  
 
Obr. 81 ukazuje volbu identických bodů. 
 

 
 

Obr. 81 Volba identických bodů - vlevo zdrojová soustava souřadnic, vpravo cílová. 
 
Pro zobrazení souřadnic identických bodů v obou souřadnicových soustavách zvolíme funkci           
View Link Table, viz obr. 82. V této tabulce můžeme případně zrušit dvojici identických bodů               
(například jsme prohodili pořadí zadání bodů). Rovněž zde volíme transformaci, kterou           
chceme použít.  



 

 
Obr. 82 Tabulka se souřadnicemi dvojic identických bodů. 
 
Pokud jsme vybrali typ transformace a zadali dostatečný počet identických bodů, můžeme si             
nechat zobrazit, jak by dopadla transformace při zadaných identických bodech. Buď v Link             
tabulce zaškrtneme volbu Auto Adjust (viz obr. 83), nebo na panelu nástrojů Georeferencing             
zvolíme rozbalovací nabídku Georeferencing a následně zaškrtneme Auto Adjust. 
 

 
Obr. 83 Georeferencování výřezu geologické mapy pomocí afinní transformace. 
 
Pokud nejsme s výsledkem spokojeni, můžeme transformaci upřesnit a přidat další pár            
identických bodů. 
 
K uložení výsledku transformace můžeme použít buď volbu Georeferencing -> Update           
Georeferencing, nebo Georeferencing -> Rectify.  
 
Pokud zvolíme možnost Update Georeferencing, uloží se informace potřebné pro umístění           
transformovaného rastru v cílové soustavě souřadnic v souboru s příponou .AUX.XML.           



Pokud bychom tento soubor z disku smazali a následně zdrojový rastr načetli, viděli bychom              
jej opět negeoreferencovaný v původním souřadnicovém systému. 
 
Druhá možnost, Rectify, vytvoří úplně nový soubor (původní soubor zůstane nezměněný),           
do kterého uloží rektifikovaný rastr. Rektifikace je obecně proces transformace jednotlivých           
pixelů z jednoho souřadnicového systému do druhého. Pro vytvoření rektifikovaného          
souboru je potřeba zadat velikost pixelu nově vytvářeného rastru (ArcMap automaticky           
vypočítá doporučenou velikost), způsob převzorkování, umístění pro nový rastr, název          
výstupního souboru, formát (např. TIFF), a případný typ komprese (viz obr. 84).  
 

 
Obr. 84 Nastavení rektifikace rastru. 
 
Kromě rektifikovaného rastru vznikne ještě jeden soubor s příponou .tfw. Tento soubor            
obsahuje informace o umístění v cílovém souřadnicovém systému. 
 
Úkol: Proveďte georeferencování nad daty, která si sami připravíte. Můžete si například            
připravit výřez geologické mapy pro jiný kraj, případně použít jakákoli jiná rastrová            
podkladová data, která následně georeferencujete. 
 
Poznámka: georeferencování lze provádět i pro vektorové datové sady, byla-li jejich           
lokalizace v souřadnicovém systému nějakým způsobem poničena, případně pro rychlou          
transformaci geodetického měření z místní souřadnicové soustavy (jakkoli v takovém          
případě je korektnéší použít geodetický postup převodu). V takovém případě použijte nástroj            
Spatial Adjustment: 

 
Obr. 85 Nastavení rektifikace rastru. 

Transformace souřadnicových systémů  
Cílem této kapitoly je ukázat vzájemnou transformaci mezi souřadnicovými systémy WGS-84           
a S-JTSK.  



 
Zdrojová data: 

● vrstva roads z datové sady Open Street Map pro území České republiky v             
souřadnicovém systému WGS-84 

● vrstva KatastralniUzemi_polygon z RÚIAN v souřadnicovém systému S-JTSK 
 
Transformace WGS-84 -> S-JTSK 
 
Spustíme si ArcMap a načteme do něj vrstvu roads. Tato vrstva je v systému WGS-84, který                
používá zeměpisné souřadnice, jednotlivé body jsou definované zeměpisnou délkou, šířkou          
a výškou. Po načtení vrstvy do ArcMap si můžeme všimnout, že se souřadnice v mapovém               
okně zobrazují ve stupních v desetinném tvaru (Decimal Degree). Pokud bychom si chtěli             
nechat zobrazovat souřadnice v jiném tvaru, můžeme nastavit požadovaný způsob          
zobrazení jednotek následovně: pravé tlačítko myši nad Layers -> Properties... -> General a             
Display. Obr. 86 ukazuje nastavení jednotek pro zobrazení pro vrstvu ve WGS-84 ve tvaru              
stupně-minuty-vteřiny (Degrees Minutes Seconds). 
 

 
Obr. 86 Nastavení jednotek pro zobrazení pro vrstvu v souřadnicovém systému WGS-84. 
 
Obecně, pokud bychom chtěli zjistit, v jakém souřadnicovém systému vrstva je, klikneme na             
ni v Table of Contents pravým tlačítkem myši, zvolíme Properties… a dále záložku Source.              
Zde najdeme informace o souřadnicovém systému a mapových jednotkách (viz obr. 87). 
 



 
Obr. 87 Zobrazení informací o souřadnicovém systému pro vrstvu roads. 
 
Pro provedení transformace použijeme nástroj Project, která pracuje s vektorovými daty .           9

Najdeme ji v ArcToolbox (Data Management Tools -> Projections and Transformations).  
 
 
V otevřeném okně Project je potřeba vyplnit následující údaje: 

● Input Dataset or Feature Class: vrstva, kterou chceme transformovat 
● Input Coordinate System: souřadnicový systém zdrojové vrstvy 
● Output Dataset or Feature Class: umístění pro transformovanou vrstvu 
● Output Coordinate System: cílový souřadnicový systém 
● Geographic Transformation: použitý transformační klíč 

 
Obr. 88 zobrazuje nastavení transformace vrstvy roads z WGS-84 do souřadnicového           
systému S-JTSK. 
 

 
Obr. 88 Nastavení transformace vrstvy roads z WGS-84 do S-JTSK. 
 

9 Pro případnou transformaci rastrových dat lze využít podobný nástroj: Project Raster 



Použitým transformačním klíčem je S_JTSK_To_WGS_1984_1 . Stejný transformační klíč        10

bychom použili i pro přechod z S-JTSK do WGS-84.  
 
Pokud si budeme chtít transformovaná data prohlédnout v systému S-JTSK, načteme je do             
ArcMap a ujistíme se, že máme v datovém rámci nastavený souřadnicový systém S-JTSK,             
případně jej nastavíme (pravé tlačítko nad Layers -> Properties… -> Coordinate System).  
 
Na obr. 89 je porovnání dat ve vrstvě roads v systémech WGS-84 a S-JTSK. 
  

 

 

Obr. 89 Vrstva roads ve WGS-84 (vlevo) a transformovaná v S-JTSK (vpravo). 
 
Transformovaná data je nyní možné kombinovat s jinými daty vyjádřenými v S-JTSK.  
 
V kapitole Přidání vrstvy z webu - WMS je ukázáno načtení WMS služby poskytující ortofoto               
v systému WGS-84. Při načtení této vrstvy do ArcMap s nastaveným souřadnicovým            
systémem S-JTSK se zobrazí okno Geographic Coordinate Systems Warning, jak je           
ukázáno na obr. XY (v kapitole Přidání vrstvy z webu - WMS). Klikneme na tlačítko               
Transformations… a zobrazí se nám okno Geographic Coordinate System Transformations,          
kde nastavíme, z jakého do kterého souřadnicového systému chceme transformovat a jaký            
použijeme transformační klíč, viz obr. XY, který zachycuje nastavení pro transformaci WMS            
služby ve WGS-84 do S-JTSK. 
 

10 Přehled zpřesňujících transformačních rovnic pro použití k převodu souř. systémů na území ČR a 
SR v ArcGIS 10. Online: 
https://www.arcdata.cz/sluzby-a-podpora-zakazniku/podpora/clanek/prehled-zpresnujicich-transforma
cnich-rovnic-pro-pouziti-k-prevodu-sour-systemu-na-uzemi-cr-a-sr-v-arcgis-10 (přistupováno 17. 8. 
2017). 



 
Obr. 90 Transformace z WGS-84 do S-JTSK.  
 
Obrázek 91 zachycuje kombinaci transformovaných dat z vrstvy roads a transformované           
WMS vrstvy ortofota. 
 
 

 
Obr. 91 Kombinace transformovaných dat z datové sady Open Street Map (vrstva roads) a              
WMS služby poskytující ortofoto. Data jsou zobrazena v souřadnicovém systému S-JTSK. 
 
Transformace S-JTSK -> WGS-84  
 
Při transformaci ze souřadnicového systému S-JTSK do WGS-84 postupujeme shodně, jako           
v předchozím případě (ArcToolbox -> Data Management Tools -> Projections and           
Transformations -> Project), pouze na vstupu je vrstva v systému S-JTSK a na výstupu pak               
vrstva ve WGS-84, viz obr. 92. 
 



 
Obr. 92 Transformace vektorové vrstvy z S-JTSK do WGS-84. 

Tvorba digitálního modelu reliéfu 

TIN 
Vstupní data: 

● vektorová vrstva Vrstevnice_Cerne_Certovo s vrstevnicemi pokrývajícími oblast       
Černého a Čertova jezera na Šumavě, 

● vektorová vrstva Zajmove_uzemi vymezující oblast pokrytou vrstevnicemi. 
 
Pro reprezentaci digitálního modelu reliéfu (DMR) se často používá nepravidelné          
trojúhelníkové sítě (Triangulated Irregular Network - TIN). TIN reprezentuje povrch jako           
soubor trojúhelníků, které jsou definovanými třemi body umístěnými v prostoru a pro tyto             
trojúhelníky uchovává topologické vztahy. Proces vytvoření TIN se nazývá triangulace.  
 
V ArcMap je triangulace (vytvoření TIN) dostupná přes funkci Create TIN (ArcToolbox -> 3D              
Analyst Tools -> Data Management -> TIN). 
 
Poznámka: funkce Create TIN je součástí rozšíření ArcGIS 3D Analyst. Abychom mohli            
funkci použít, musíme nejprve v ArcMap toto rozšíření povolit (menu Customize ->            
Extensions; viz obr. 93). 
 



 
Obr. 93 Zapnutí rozšíření 3D Analyst. 
 
V okně Create TIN nastavíme umístění pro výstupní TIN a vstupní data, ze kterých se má                
TIN vytvořit. TIN budeme vytvářet ze zdrojové vrstvy obsahující vrstevnice. Informace o            
výšce je ve vstupní vrstvě uložena v atributu Z. Jednotlivé body (vrcholy) se budou              
triangularizovat jako Mass_Points, tzn. jako běžné body, které určují hodnotu (např. výšku),            
která je v daném místě. Při tvorbě TIN však nemusí tvořit vrchol trojúhelníku, jsou-li v rámci                
optimalizace vyřazeny.  
 



 
Obr. 94 Vytvoření TIN ze zdrojových dat - vrstevnic. 
 

 
Obr. 95 TIN vytvořený pro oblast Černého a Čertova jezera. 
 



Pomocí triangulace vzniká vždy konvexní TIN – pomocí obálky můžeme tento konvexní TIN 
oříznout na nekonvexní. Náš vytvořený TIN ořízneme (clip) vektorovou vrstvou s           
vymezujícím polygonem. Pro oříznutí použijeme funkci Edit TIN. Typ oříznutí zvolíme           
Soft_Clip. Tím zajístíme, že na hranách po obvodu bude původní výška. Hard_Clip by bylo              
vhodné použít, pokud bychom TIN ořezávali polygonem se souřadnicemi ve 3D. Pokud            
bychom zvolili Hard_Clip pro oříznutí polygonem s chybějící výškovou souřadnicí, na obvodu            
TIN by hrany měly výšku Z = 0. 
 

 
Obr. 96 Oříznutí TIN polygonem vymezující oblasti.  
 

 



 
Obr. 97 TIN oříznutý vrstvou vymezující zájmové území. 
 

 
 
Obr. 98 Vizualizace TIN v ArcScene. 
 
Volitelně zkuste do ArcScene přidat vrstvu Topograficka_mapa_Cerne_Certovo.tif a v         
záložce Base Heights jí přidat výškové hodnoty převzaté z vytvořené trojúhelníkové sítě. 

GRID 
Vstupní data: 

● TIN vytvořený z vrstevnic pro oblast Černého a Čertova jezera (viz kapitola TIN) 
 
DMR je možné v GIS reprezentovat rovněž jako mříž (grid). Převod z TIN do mříže se                
nazývá interpolace. ArcMap nabízí pro převod TIN na mříž funkci TIN to Raster (ArcToolbox              
-> 3D Analyst Tools -> Conversion -> From TIN).  
 
Pro převod z reprezentace TIN na mříž můžeme ve funkci TIN to Raster zvolit buď lineární                
interpolaci (linear interpolation), nebo interpolací pomocí metody přirozených sousedů         
(natural neighbors interpolation).  
 



 
Obr. 99 Převod TIN na mříž. Pro převod je použita lineární interpolace. Sampling distance              
nastavte na CELLSIZE = 10; tím vznikne DMR s velikostí buňky 10x10m. 
 

 
Obr. 100 DMR reprezentovaný ve formě mříže.  



Interpolace a rasterizace 

Přímá interpolace digitálního modelu reliéfu z vstupních bodů 
Vstupní data: 

● Bodová vrstva VyskoveBody_Cerne_Certovo s nadmořskými výškami uloženými v 
atributu nadm_vyska. 

● Plošná vrstva Zajmove_uzemi vymezující oblast pokrytou vrstevnicemi. 
 
Poznámka: Protože budeme používat funkce z nadstavby Spatial Analyst, tak si nejprve tuto             
nadstavbu musíme povolit (menu Customize -> Extensions). 
 
Interpolujeme povrch přímou interpolací z bodové vrstvy. Použijme k tomu nejprve metodu 
IDW a následně i metodu Topo To Raster (obě nalezneme v ArcToolbox -> Spatial Analyst 
Tools -> Interpolation): 

 
Obr. 101 Interpolace DMR metodou inverzní vážené vzdálenosti (IDW). 



 
Obr. 102 Použití funkce Topo to Raster. 
 



Vypočítané povrchy ořízněme vrstvou Zajmove_uzemi (ArcToolbox -> Data Management 
Tools -> Raster -> Raster Processing -> Clip). Nezapomeňme zatrhnout volbu Use Features 
for Clipping Geometry! 

 
Obr. 103 Použití funkce Clip. 
 
Oříznuté povrchy obarvěte vhodnou barevnou škálou a s vyučujícím diskutujme rozdíly v            
interpolaci povrchu různými metodami (převodem přes TIN, přímá interpolace různými          
metodami - IDW a Topo to raster). Zaměřme se zejména na oblast údolnic, hřbetnic a               
vodních ploch. Porovnání provádějme ve 2D i ve 3D. 



 
Obr. 104 Barevná škála pro vizualizaci digitálního modelu reliéfu. 

Rasterizace vrstevnic  
Vstupní data: 

● Liniová vrstva Vrstevnice_Cerne_Certovo s vrstevnicemi pokrývajícími oblast       
Černého a Čertova jezera na Šumavě 

 
V této ukázce použijeme funkci Polyline To Raster (k nalezení v ArcToolbox -> Conversion              
Tools -> To Raster ), abychom ukázali rozdíl mezi rasterizací a interpolací.  



 
Obr. 105 Použití funkce Polyline to Raster. 
 
Jak můžeme vidět na obrázku 106, rasterizací, na rozdíl od interpolace, nevzniká souvislý             
povrch, pouze otisk vektorové vrstvy. Srovnejme s interpolací DMR z výškových bodů (viz             
kapitola Přímá interpolace DMR z vstupních bodů.  
 
Poznámka: v některých verzích cvičných dat není nadmořská výška uložená v atributu            
[nadm_vyska], ale v atributu [Z]. 



 
Obr. 106 Rasterizovaná vrstva vrstevnic 

Interpolace výnosového potenciálu 
Vstupní data: 

● Bodová vrstva YieldMeasurement2017 obsahující body měřených výnosů (yield) z         
roku 2017 (atribut YieldMeasu označuje v procentech hodnotu, o jakou se v daném             
místě bude výnos lišit oproti průměrnému výnosu, kde průměrný výnos má hodnotu            
100 %) 

● Plošná vrstva RosteniceFields obsahující areály pozemků zemědělského družstva        
Rostěnice 

Za zapůjčení dat děkujeme farmě Rostěnice a.s. a Mendelově univerzitě v Brně.  



Poznámka: povšimněme si souřadnicového systému dat. 
 
Cílem ukázky je interpolace předpokládaného výnosového potenciálu pro celou plochu          
pozemků. Vyzkoušejme různé interpolační techniky.  
 
Poznámka: pro použití nástrojů pro interpolaci je zapotřebí mít zapnuté rozšíření Spatial            
Analyst (menu Customize -> Extensions; v dialogu zaškrtnout Spatial Analyst) 
  
Nejprve interpolujme metodou inverzní vážené vzdálenosti (ArcToolbox -> Spatial Analyst 
Tools -> Interpolation -> IDW): 

 
Obr. 107 Interpolace pomocí metody IDW. 
 
Dále vyzkoušejme interpolaci metodou pomocí spline ploch (ArcToolbox -> Spatial Analyst 
Tools -> Interpolation -> Spline): 



 
Obr. 108 Interpolace pomocí metody Spline. 
 
Alternativně vyzkoušejme další interpolační metody z Toolboxu Interpolation: Natural         
Neighbour, Kriging. 
 
Vypočítané povrchy výnosového potenciálu ořízněme vrstvou Rostenice_Fields (ArcToolbox        
-> Data Management Tools -> Raster -> Raster Processing -> Clip. Nezapomeňme            
zatrhnout volbu Use Features for Clipping Geometry! 
 
Poznámka: Při zadávání “Output Raster Dataset” je velikost výstupu omezena na maximálně            
13 znaků. 
 



 
Obr. 109 Oříznutí povrchů výnosového potenciálu pomocí funkce Clip. 
 
Oříznuté povrchy zobrazme barevnou škálou vhodnou pro výnosový potenciál: 



 
Obr. 110 Výběr barevné škály vhodné pro výnosový potenciál. 

 
Obr. 111 Dvě různé interpolace výnosového potenciálu (vlevo metodou IDW, vpravo jako 
regularizovaný spline). 
 
S vyučujícím diskutujme rozdíly v interpolaci výnosového potenciálu různými metodami. 



 

 

Mapová algebra 
Vstupní data: 

● Plošná vrstva RosteniceFields obsahující areály jednotlivých polí zemědělského        
družstva Rostěnice 

● Rastrová vrstva YieldPotenialSpline_Clipped.tif obsahující interpolovaný výnosový      
potenciál ořezaný na jednotlivá pole. V každé buňce je uložena hodnota, o jakou se v               
daném místě bude výnos lišit oproti průměrnému výnosu (průměrný výnos má           
hodnotu 100 %). 

 
Otevřeme ArcMap a do projektu načtěme vstupní data z disku počítače. Následně ze služby              
ArcGIS online (File / Add Data / Add Data from ArcGIS Online ...) dále připojme vrstvu                
Digitálního modelu reliéfu České republiky 5. generace (DMR 5G), viz obrázek 112 a vrstvu              
Digitálního modelu povrchu první generace (DMP 1G). Přidávejme služby vytvořené přímo           
Zeměměřickým úřadem (Image Service by zem_urad). Při přidávání vrstev dbejme          
nastavení vhodné transformace mezi souřadnicovými systémy (viz informace o         
souřadnicových systémech) 

 
Obr. 112 Připojení vrstvy Digitálního modelu reliéfu České republiky 5. generace (DMR 5G)             
z ArcGIS online. 
 
Přidané vrstvy mají na sobě aplikovanou symboliku ve formě stínování. To je vhodné pro              
vizualizaci, nelze to však použít pro analytickou práci. Proto po kliknutí na vlastnosti vrstvy              
(aplikujeme jak na vrstvu DMR5G tak i na DMP1G) vybereme záložku ProcessingTemplates            
(v ArcMap verze 10.2 jde o záložku Server Functions), kde vypneme aplikovanou symboliku             
(volbu parametru Function:GrayscaleHillshade přepneme na Function:None). Tím získáme        



 

sice vizuálně nic neříkající obraz, který však v hodnotách buněk obsahuje informaci o             
nadmořských výškách (možno ověřit nástrojem Identify). 
 
Protože budeme dále pracovat s daty z webové služby (obsahující DMR a DMP celé České               
republiky), je velice důležité si pro další práci nastavit pracovní prostor, ve kterém budeme              
všechny následující analýzy provádět! Proto se přibližme do oblasti vrstvy RosteniceFields           
na prostorově menší oblast (cca 3000 x 3000 metrů) a nastavme Geoprocessing /             
Environments / Processing Extent / Same as Display (alternativně použijme bookmark Výřez            
pro výpočet nDMP v předpřipraveném záchranném dokumentu MapovaAlgebra.mxd). Stejně         
tak, pokud se nepodaří připojit k výše zmíněným službám, použijme lokálně uloženou kopii             
DMR5G.tif a DMP1G.tif. 
 

 
Obr. 113 Nastavení pracovního prostoru, ve kterém budeme provádět prostorové analýzy. 
 

Lokální funkce mapové algebry - výpočet normalizovaného digitálního 
modelu povrchu 
Procvičme si lokální funkci mapové algebry tak že od Digitálního modelu povrchu odečteme             
digitální model reliéfu, vyjde nám normalizovaný digitální model povrchu (nDMP), zobrazující           
výšku vegetace a výšky antropogenních prvků ~ staveb. Použijme v ArcToolboxu funkci            
Minus (ArcToolbox / Spatial Analyst Tools / Math / Minus), viz obr. 114. Nezapomeňme pro               
její užití aktivovat rozšíření Spatial Analyst v menu Customize / Extensions … 
 



 

Obr. 114 Nástroj pro výpočet normalizovaného digitálního model povrchu pomocí funkce           
Minus (nahoře) a jeho výsledek - zeleně vystupující oblasti zobrazují budovy a vegetace             
(dole). 
 
Poznámka: Povšiměme si, že v zmíněné složce Math se nalézají i další lokální funkce              
mapové algebry, zejména Plus, Divide a Times. Nástroje využívající lokální funkce mapové            
algebry lze též nalézt v ArcToolbox / Spatial Analyst Tools / Map Algebra / Map Calculator. 

Fokální funkce mapové algebry - výpočet gradientu a orientace změn 
výnosového potenciálu 
Nejběžnějším využitím fokální funkce mapové algebry je bezesporu výpočet sklonu a           
orientace svahu (viz kapitola zabývající se analýzou povrchů). Tyto funkce lze ale obecně             
aplikovat i na jiné vrstvy. Například výpočet “sklonu” (ArcToolbox / Spatial Analyst Tools /              
Surface / Slope), zde obecněji gradientu, výnosového potenciálu        



(YieldPotentialSpline_Clipped.tif) vytvoří povrch nesoucí informaci o největších změnách ve         
výnosovém potenciálu v prostoru (obr. 115). Tuto vrstvu lze interpretovat tak, že čím             
heterogennější je pole, k tím větším změnám výnosového potenciálu na nich dochází.            
Žádoucí jsou přitom spíše homogenní celky.  
 

 

 
Obr. 115 Aplikace funkce Slope na vrstvu výnosového potenciálu (nahoře) a výsledek (dole).  

Zonální funkce mapové algebry 
Při práci s zonální funkcí mapové algebry nejčastěji počítáme základní statistické informace            
o nějakém v prostoru spojitě se měnícím jevu v zájmových zónách. Lze si představit              
například výpočet minimálního a maximálního sklonu svahu (jev) pro jednotlivá povodí           



(zóna) veličině. Dalším příkladem může být výpočet minimální, maximální a průměrný           
výnosový potenciál (jev) pro jednotlivá pole (zóny). 
 
Spočítejme proto minimální, maximální a průměrný sklon polí na farmě Rostěnice resp. v             
oblasti, pro kterou máme k dispozici digitální model reliéfu (pozor zde nemá smysl počítat              
takovéto hodnoty z digitálního modelu povrchu, který není očištěn o vegetaci a antropogenní             
prvky). 
 
Z DMR 5G tedy nejprve spočítejme rastr sklonu svahů (ArcToolbox / Spatial Analyst Tools /               
Surface / Slope ~ nastavení parametrů a použití funkce Slope viz kapitola o Rastru sklonu               
svahů). 
 

 
Obr. 116 Výpočet rastru sklonu svahů z DMR 5G. 

 
Následně spusťme funkci ArcToolbox / Spatial Analyst Tools / Zonal / Zonal Statistics s              
parametry vyobrazenými na obrázku 117. Výsledkem je rastr s hodnotou buňky rovnou            
průměrnému sklonu svahu v každé zóně. 



 

Obr. 117 Funkce Zonal Statistic (nahoře) počítající průměrnou hodnotu sklonu pro každé            
pole ve vrstvě RosteniceFields.shp. Čím tmavší barva, tím větší průměrná hodnota na poli             
(dole). (Prostorový rozsah území na obrázku odpovídá oblasti bookmarku Výřez pro výpočet            
nDMP v předpřipraveném záchranném dokumentu MapovaAlgebra.mxd). 
 
Vzhledem k tomu, že každá zóna na obr. 117 obsahuje mnoho buněk s naprosto stejnou               
hodnotou (neefektivita uložení), a vzhledem k tomu, že takto lze spočítat vždy pouze jednu              
statistickou veličinu, zde průměr (neefektivita ve výpočtu), používá se více funkce           
ArcToolbox / Spatial Analyst Tools / Zonal / Zonal Statistics As a Table (obr. 118). Po                
spuštění funkce dojde k výpočtu a k uložení jeho výsledků do atributové tabulky             
RosteniceFieldsSlopeZones.dbf.  



 
Obr. 118 Použití funkce/nástroje Zonal Statistics As a Table. 

 
Obr. 119 Atributová tabulka vrstvy RosteniceFieldsSlopeZones.  
 
Pozor, tato tabulka je automaticky přidána do aktuálního projektu a protože nemá žádnou             
prostorovou lokalizaci, ArcMap zareaguje přepnutím zobrazení Table of Content podle          
metody “List By Source”, pro přepnutí zpět do zobrazení podle pořadí vykreslování (“List By              
Drawing Order” přepněte na ikonu pod zelenou tečkou (obr. 120). 

 
Obr. 120 přepínámí mezi metodami vykreslování. 



 
Po propojení prvkové třídy RosteniceFields (pravé tlačítko myši nad RosteniceFields ->           
Joins and Relates -> Join…) s atributovou tabulkou RosteniceFieldsSlopeZones přes          
primární a cizí klíč RosteniceFields.FID a RosteniceFieldsSlopeZones.FID je pak možné          
data vizualizovat (pravé tlačítko myši nad vrstvou RosteniceField -> Properties ->           
Symbology) obdobně jako při užití funkce Zonal Statistics. Data jsou však ve vektorové             
formě, t.j uložena úsporněji a zároveň máme možnost přepínat vizualizaci podle různých            
atributů. Při procházení výsledků si jen uvědomme, že zonální statistika byla vypočtena            
pouze pro zóny, pro které máme vstupní povrch sklonů svahů, některé zóny tedy nemají              
atribut vyplněn (obr. 121). 

 

 
Obr. 121 Prostorová vizualizace průměrných sklonů svahů jednotlivých zón (nahoře) a           
kompletní pohled na propojená data prvkové třídy RosteniceFields s atributovou tabulkou           
RosteniceFieldsSlopeZones (dole). 
 
Výzva: V základu lze samozřejmě počítat podobné charakteristiky přímo pro nadmořskou           
výšku nebo naopak pak i pro analytické vrstvy pro výnosový potenciál.  



Globální funkce mapové algebry - odstranění bezodtokých oblastí 
Globální funkce mapové algebry potřebuje pro výpočet jedné buňky výstupního rastru           
(potenciálně) všechny buňky vstupního rastru (nelze vymezit zóny o pevných hranicích, ze            
kterých výstupní buňky počítat. Nejjednodušším příkladem je vyhledání globálních extrémů          
(např. minima, maxima) v rámci celého vstupního rastru) jedná se v podstatě o obdobu              
zonální analýzy, kde zónou je celý rastr. 
 
Zajímavějším příkladem je vyhledání sníženin (sinks) v digitálním modelu reliéfu. To jsou            
oblasti, ve kterých se v krajině drží voda. Těmito sníženinami mohou být jednak interpolační              
chyby, ale i lokální deprese nebo například rybníky. Tyto sníženiny se funkcí ArcToolbox /              
Spatial Analyst Tools / Hydrology / Fill vyplní po okraj (obr. 122). Výstupem z funkce je                
digitální model reliéfu zbavený lokálních sníženi. Takový povrch se pak používá v dalších             
hydrologických analýzách, někdy je nazýván hydrologicky korektním modelem reliéfu. Z          
DMR 5G tedy (například v oblasti bookmarku Výřez pro výpočet nDMP v předpřipraveném             
záchranném dokumentu MapovaAlgebra.mxd) spočtěme hydrologicky korektní model       
reliéfu. 

 
Obr. 122 Funkce Fill, která vyplní lokální sníženiny a vytvoří tak hydrologicky korektní model              
reliéfu. 
 
Po provedení výpočtu neuvidíme příliš rozdílů mezi vstupním a výstupním povrchem. Pokud            
od sebe oba povrchy odečteme (viz kapitola o lokální funkci mapové algebry) a aplikujeme              
na výsledek vhodnou symboliku (~ vizualizujeme pouze buňky s nenulovým rozdílem +            
použijeme vhodnou barevnou škálu), uvidíme vyplněné oblasti (viz obr. 123). 



 
Obr. 123 Vyplněné bezodtoké oblasti 

Analýzy povrchů 
Analýzy povrchů jsou prováděny nad digitálním modelem nějakého povrchu (typicky DMR).           
ArcMap obsahuje pro analýzy DMR řadu funkcí dostupných buď v ArcToolbox, případně            
panelu nástrojů 3D Analyst. 
 
Vstupní data: 

● DMR reprezentovaný ve formě rastru (vytvořený v kapitole GRID) 
● DMR reprezentovaný ve formě TIN (vytvořený v kapitole TIN) 

Rastr sklonu svahů (slope) 
Funkce Slope pro výpočet rastru sklonu svahů je dostupná přes ArcToolbox -> 3D Analyst              
Tools -> Raster Surface -> Slope. 
 
Parametry funkce Slope (viz obr. 124): 

● povinné: 
○ Input raster - vstupní rastr.  
○ Output raster - výstupní rastr. 

● volitelné: 
○ Output measurement - vypočítaný povrch udává hodnotu sklonu svahu buď          

ve stupních (hodnota DEGREE), či procentech (hodnota PERCENT_RISE). 
○ Z factor - výchozí hodnota je 1. 

 



 
Obr. 124 Nastavení funkce Slope. 

 
Obr. 125 Rastr sklonu svahů (ve stupních). 

Rastr směru sklonu svahů (aspect) 
Funkce Aspect pro výpočet rastru směru sklonu svahů je dostupná přes ArcToolbox -> 3D              
Analyst Tools -> Raster Surface -> Aspect. 
 
Parametry funkce Aspect: 

● povinné: 
○ Input raster - vstupní rastr.  
○ Output raster - výstupní rastr. 



 

 
Obr. 126 Rastr směru sklonu svahů. 

Analýza osvětlení reliéfu 
Funkce Hillshade pro výpočet osvětlení reliéfu je dostupná přes ArcToolbox -> 3D Analyst             
Tools -> Raster Surface -> Hillshade. 
 
Parametry funkce Hillshade (viz obr. 127): 

● povinné: 
○ Input raster - vstupní rastr.  
○ Output raster - výstupní rastr. 

● nepovinné: 
○ Azimuth - azimut zdroje světla. Lze zadat celočíselnou hodnotu z intervalu <0;            

360>. Výchozí hodnota je 315. 
○ Altitude - úhel nad horizontem. Lze zadat celočíselnou hodnotu z intervalu <0;            

90>. Výchozí hodnota je 45. 
 



 
Obr. 127 Nastavení funkce Hillshade.  
 

 
Obr. 128 Rastr znázorňující osvětlení reliéfu. 

Tvorba izočar (vrstevnic) 
Funkce Contour pro výpočet vrstevnic je dostupná přes ArcToolbox -> 3D Analyst Tools ->              
Raster Surface -> Contour. 
 
Parametry funkce Contour (viz obr. 129): 

● povinné: 
○ Input raster - vstupní rastr.  
○ Output polyline features - výstupní vektorová vrstva s vrstevnicemi. 
○ Contour interval - interval vrstevnic. 

● nepovinné: 
○ Base contour  - výchozí hodnota je 0. 



○ Z factor - výchozí hodnota je 1. 

 
Obr. 129 Generování vrstevnic z DMR. Zvolený interval vrstevnic je 10 m. 
 

 
Obr. 130 Vygenerované vrstevnice spolu s DMR. 

Generování profilů 
Nejprve nad TIN vytvoříme linii (funkce Interpolate Line na panelu nástrojů 3D Analyst) ve              
směru, ve kterém chceme určovat profil. Následně vybereme funkci Profile Graph (rovněž na             
panelu nástrojů 3D Analyst). Vytvoří se graf (viz obr. 131), který můžeme ješte dále              
upravovat.  
 
 



  

Obr. 131 Linie pro výpočet profilu (vlevo) a vypočtený profil (vpravo). 

Analýza viditelnosti 
Příkladem analýzy viditelnosti může být zjištění viditelnosti z daného bodu.  
 
Vytvoříme novou bodovou vrstvu a nad DMR (TIN) do ní zvektorizujeme bod, ze kterého              
budeme zjišťovat viditelnost v dané oblasti. Následně pomocí funkce Interpolate Shape           
(ArcToolbox -> 3D Analyst Tools -> Functional Surface -> Interpolate Shape) přiřadíme            
novému bodu výšku z DMR (TIN), viz obr 132. 
 
 

 
Obr. 132 Bod ve vrstvě Rozhledna dostane přiřazenou výšku z TIN. 
 
Viditelnost z bodu s přiřazenou výškou pak spočteme pomocí funkce Viewshed (ArcToolbox            
-> 3D Analyst Tools -> Visibility -> Viewshed).  
 
Povinné parametry funkce Viewshed (viz obr. 133): 

● Input raster - vstupní rastr s DMR.  
● Input point or polyline observer features - vektorová vrstva s bodem, ze kterého se              

počítá viditelnost. 
● Output rastr - výstupní rastr viditelnosti. 

○  



 

 
Obr. 133 Nastavení funkce Viewshed. 
 

 
Obr. 134 Vypočtení rastr viditelnosti z daného bodu na povrchu. 
 
 



Vzdálenostní analýzy nad rastrovými daty 
Vzdálenostní analýzy jsou poměrně časově náročné na přípravu vstupních dat. Pro           
demonstraci funkcionality GIS v oblasti vzdálenostních analýz jsou proto data již připravena. 
 
Poznámka: Pro další postup si nezapomeňte povolit rozšíření Spatial Analyst (Customize ->            
Extensions).  

Výpočet povrchu nákladů a povrchu vážené vzdálenosti 
Postup tvorby povrchu nákladů a z něj odvozeného povrchu vážené vzdálenosti je detailně             
probrán na příslušné přednášce . Nejprve je potřeba spočítat povrch nákladů, poté povrch            11

vážené vzdálenosti a nakonec nejlevnější cestu. 

Povrch nákladů 
Připomeňme, že pro výpočet povrchu nákladů je použita lokální funkce mapové algebry,            
když jsou seskládávány jednotlivé faktory do sebe. Pro zájemce, rastry reprezentující           
jednotlivé složky frikčního povrchu (povrchu odporu krajinného pokryvu), naleznete ve          
složce ZdrojoveRastry a to včetně doporučení na jejich ohodnocení: 
 
Tabulka 1. Doporučené ohodnocení jednotlivých faktorů 

 
 

11 http://youtu.be/j9gtPrMrUEU  

http://youtu.be/j9gtPrMrUEU


Výsledný frikční povrch je pak složen dohromady reklasifikací hodnot vstupních rastrů podle            
výše uvedené tabulky a následným součtem hodnot všech rastrů pomocí nástroje           
ArcToolbox / Spatial Analyst Tools / Map Algebra / Raster Calculator případně nástroje             
ArcToolbox / Spatial Analyst Tools / Math / Plus a naleznete jej ve stejném adresáři               
(ZdrojoveRastry). 
 
Výsledný povrch nákladů zahrnuje kromě frikčního povrchu i faktor terénního reliéfu,           
zkombinované dohromady podle empiricky odvozeného vzorce:  
 
((0,25*([sklon svahu uvedený ve stupních]+1))+[frikční povrch])/2 

 
Sklon svahu (k nalezení v podadresáři ZdrojoveRastry) lze spočítat nástrojem ArcToolbox / ..             
/ Slope s nastavením výpočtu ve stupních;  
  
Vzorec počítající PovrchNakladu lze následně spočítat nástrojem Raster Calculator nebo          
kombinací nástrojů ze skupiny ArcToolbox / Spatial Analyst Tools / Math. Výsledný rastr             
PovrchNakladu naleznete ve stažených datech: 
 



 
Obr. 135 Povrch nákladů vyjádřený rastrem, symbolizovaný za pomoci: 



 
Obr. 136 Symbolika užitá pro vizualizaci povrchu nákladů, povšimněme si zejména volby            
Histogram Equalize a  Invert Histogram. 
 

Povrch vážené vzdálenosti 
Vstupem pro výpočet povrchu vážené vzdálenosti je v předešlé podkapitole spočtený           
PovrchNakladu.tif a bodová vrstva určující centrum nebo centra, do kterých je povrch            
vážené vzdálenosti počítán (zde VyjezdovyBod.shp). 
 
Vlastní výpočet povrchu vážené vzdálenosti (PovrchVazeneVzdalenosti.tif) provedeme       
spuštěním funkce ArcToolbox / Spatial Analyst Tools / Distance / Cost Distance s níže              12

uvedenými parametry (viz obr. 137). Pro následující analýzy budeme potřebovat i tzv            
backlink raster - rastr “sklonů svahů” nově vzniklého povrchu vážené vzdálenosti; umístění            
pro backlink raster rovněž zadáme v nastavení funkce Cost Distance (viz obr. 137). Na              
obrázku 137 je rovněž vidět tlačítko “Environments...” pro nastavení hodnot prostředí, které            
ovlivňují výpočet povrchu vážené vzdálenosti. Jednou z těchto hodnot prostředí, kterou je při             
výpočtu potřeba nezapomenout uvést, je tzv. processing extent, takže klikneme právě na            
tlačítko “Environments...” a nastavíme processing extent, viz obr. 138. 
 

12 Všechny další analytické funkce vztahující se k vzdálenostním analýzám se nacházejí ve stejném 
toolboxu. 



Na obr. 139 a 140 si prohlédněme vypočtené povrchy. Volitelně, manipulací s vrstvou             
VyjezdovyBod.shp, můžeme vyzkoušet výpočet nejlevnější cesty z různých výjezdových         
míst. 
 

 
Obr. 137 Použití funkce Cost Distance pro výpočet povrchu vážené vzdálenosti.  
 

 
Obr. 138 Nastavení Processing Extent. 



 
Obr. 139 Výsledný povrch vážené vzdálenosti. 



 
Obr. 140 Výsledný backlink raster - rastr “sklonů svahů” nově vzniklého povrchu vážené             
vzdálenosti. 

Nalezení nejlevnější cesty 
Vstupem pro analýzu nalezení nejlevnější cesty (Cost Path) je v předešlé podkapitole            
spočtený PovrchVazeneVzdalenosti.tif a BackLink.tif, dále pak místo (MistoUdalosti.shp), ze         
kterého chceme spočítat nejlevnější cestu do nejbližšího z center, do kterých je povrch             
vážené vzdálenosti počítán. Vlastní výpočet nejlevnější cesty (NejlevnejsiCesta.tif)        
provedeme spuštěním funkce Cost Path s níže uvedenými parametry (viz obr. 141).            
Výslednou nejlevnější cestu si prohlédněme na obrázku 142.  
 
Volitelně převeďme výsledek na vektor (nástroj Raster To Polyline) nebo porovnejme s            
topografickým podkladem přidaným z ArcGIS Online, např. Základní mapou ČR, obr. 143.            
Dále, manipulací s vrstvou MistoUdalosti.shp můžeme vyzkoušet výpočet nejlevnější cesty z           
různých míst. 



 
Obr. 141 Parametry nástroje Cost Path. 



 
Obr. 142 Nalezená nejlevnější cesta porovnaná s povrchem vážené vzdálenosti.  
 



 
Obr. 143 Nalezená nejlevnější cesta porovnaná s topografickým podkladem přidaným z           
ArcGIS Online, konkrétně Základní mapou ČR. 
 

Vymezení spádových oblastí 
Vstupem pro vymezení spádových oblastí (Cost Allocation) je PovrchNakladu.tif (spočtený v           
podkapitole Povrch Nákladů nebo k nalezení v podkladových datech) a dále pak výjezdová             
centra (VyjezdovyBod.shp), pro která chceme vymezit spádové oblasti. Nastavení parametrů          



viz obr. 144. Vymezené spádové oblasti (SpadoveOblasti.tif) si prohlédněme na obrázku           
145.  
 
Volitelně převeďme výsledek na vektor (nástroj Raster To Polygon) a porovnejme s            
povrchem vážené vzdálenosti (obr. 146) nebo topografickým podkladem přidaným z ArcGIS           
Online, např. Základní mapou ČR, obr. 147. Dále, manipulací s vrstvou VyjezdniBod.shp,            
můžeme vyzkoušet výpočet spádových oblastí pro různá centra. 
 

 

 
Obr. 144 Parametry nástroje Cost Allocation. 



 
Obr. 145 Vymezené spádové oblasti. 



 
Obr. 146 Vymezené spádové oblasti porovnané s povrchem nákladů. 
 



 
Obr. 147 Vymezené spádové oblasti porovnané s topografickou mapou. 
 

 


